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TRADEMARKS
Alconox is a registered trademark of the Alconox Company.
AutoPore is a registered trademark of Micromeritics Instrument Corporation.
Micromeritics is a registered trademark of Micromeritics Instrument Corporation.
Microsoft, Windows, and Windows 7 are registered trademarks of Microsoft Corporation.
Swagelok is a registered trademark of Swagelok.

This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code is provided under
the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the
use of or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to
alter it and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of
conditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list
of conditions in documentation and/or other materials provided with the distribution.

3. Altered versions — including, but not limited to, ports to new operating systems, existing ports with new
graphical interfaces, and dynamic, shared, or static library versions — must be plainly marked as such and
must not be misrepresented as being the original source. Such altered versions also must not be mis-
represented as being Info-ZIP releases — including, but not limited to, labeling of the altered versions with
the names "Info-ZIP" (or any variation thereof, including, but not limited to, different capitalizations), "Pocket
UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such altered versions are further pro-
hibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases

Copyright

The software described in thismanual is furnished under a license agreement andmay be used or
copied only in accordance with the terms of the agreement.

______________________________________________________________________________

Copyright © 2014 - 2017. Micromeritics Instrument Corporation. All rights reserved.



WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any instrument or
defective parts when returned prepaid to us and which our examination discloses to have been defective. The purchaser is
responsible for all transportation charges involving the shipment of materials for warranty repairs. Failure of any instrument
or product due to operator error, improper installation, unauthorized repair or alteration, failure of utilities, or environmental
contamination will not constitute a warranty claim. The materials of construction used in MICROMERITICS instruments and
other products were chosen after extensive testing and experience for their reliability and durability. However, these
materials cannot be totally guaranteed against wear and/or decomposition by chemical action (corrosion) as a result of
normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization to
return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are made by
persons other than its own authorized service personnel unless such work is authorized in writing by MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respective
brand names or trade names. We, therefore, make no express or implied warranty as to such products. We shall use
our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or replacement
of such of his products that may prove defective in workmanship or materials. Service charges made by such man-
ufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to such products,
except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion of
MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items which
perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of manufacturing
defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its products
other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including but not
limited to, the implied warranties of merchantability or fitness for use.

Warranty
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Contact Us

CONTACT US
Micromeritics Instrument Corporation

4356 CommunicationsDrive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696

www.Micromeritics.com

---------------

U.S. Inquiries

U.S. Sales Phone: 1-770-662-3636

USSales@Micromeritics.com

---------------

Quotes, Orders, and Customer Satisfaction

Customer Service Phone: 1-770-662-3636

Orders@Micromeritics.com

---------------

U.S. Instrument Service Department

U.S. Service Department Phone: 1-770-662-3666

Service.Helpdesk@Micromeritics.com

---------------

Micromeritics Scientific Services

Customer Support Portal

http://techsupport.micromeritics.com/portal
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ABOUT THIS MANUAL

Log in to your customer portal to access the following:

l Calculations
l Error Messages
l AutoPore IV Operator Manual in PDF format

Parts and accessories can be found online at www.Micromeritics.com.

The following iconsmay be found in thismanual:

NOTE - Notes contain important information applicable to the topic.

CAUTION - Cautions contain information to help prevent actions that may damage the
analyzer or components.

WARNING - Warnings contain information to help prevent actions that may cause per-
sonal injury.

About thisManual
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1 ANALYZER COMPONENTS

FRONT PANEL

Component Description

High Pressure Ports
[LED light]

Pressurized. Illuminateswhen the high pressure system is
pressurized, when the computer system is not connected, or when the
computer is connected but the application is not running.

Low Pressure Ports
[LED light]

Pressurized. Illuminateswhen the low pressure system is
pressurized, when the computer system is not connected, or when the
computer is connected but the application is not running.

Hg Up. Illuminateswhen the amount of mercury in the low pressure
system is sufficient to fill the penetrometers.

Hg Drained. Illuminateswhenmercury has been drained from the low
pressure system.

Power [LED light] Illuminateswhen power is supplied to the analyzer.

Front Panel Components

1 Analyzer Components
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1 Analyzer Components

REAR PANEL

Component Description

Aux RS232 Port Used by service personnel.

Ethernet Port Port for an Ethernet cable allowing communication between the ana-
lyzer and the computer.

Exhaust Port Provides ventilation for the analyzer. This exhaust can be vented to the
outside using flexible tubing similar to the type used on a home clothes
dryer, and a vent systemwhich pulls air from the exhaust port.

Gas Inlet Port Used for connecting an external gas supply to the analyzer when gen-
erating pressures in the low pressure system.

Power cord connector For setting the power voltage and connecting the analyzer to the
power supply.

Power Switch Powers the analyzer on and off. It also provides electrical overload pro-
tection.

Reset buttons 10 Amp.Resets the internal vacuum pump.

25 Amp.Resets the internal vacuum pump in a high pressure
analyzer.

Rear Panel Components
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THE BASIC WORKFLOW

Before a sample can be analyzed, it must be:

1. Weighed and themass recorded, and
2. A sample file must be created that describes the sample and gives the analysis conditions and

other parameters for the analysis. This file also includes a pressure table, which lists the pres-
sure points at which data are collected during the analysis.

To begin the analysis, a sample is placed in a penetrometer then the penetrometer is installed into a
low pressure port. The low pressure analysis consists of two phases:

1. The first phase is the evacuation of gases from the penetrometer. The penetrometer is then
filled automatically with mercury.

2. The second phase is the collection of data at pressures up to and including the last low
pressure point specified in the pressure table.

When the low pressure analysis is complete, remove the penetrometer from the low pressure port
and weigh it, then install it in a high pressure port. Themass of the penetrometer with sample and
mercury can be entered in the sample file or in the window for starting the high pressure analysis.

Pore volume data are calculated by determining the volume of mercury remaining in the
penetrometer stem. As pressure increases, mercurymoves into the sample’s pores, vacating the
stem (this is called intrusion). Intrusion of different size pores occurs at different pressures. (The
greater the pressure, the smaller the pore diameter into which themercury can be forced.) Because
mercury has a high surface tension and is nonwetting tomost materials, its angle of contact and
radius of curvature can be used to calculate the pore diameter into which it intrudes at a given
pressure.

The volume of mercury in the penetrometer stem ismeasured by determining the penetrometer
electrical capacitance. Capacitance is the amount of electrical charge stored per volt of electricity
applied. The penetrometer capacitance varies with the length and diameter of the penetrometer
stem that is filled with mercury.

When the penetrometer is initially filled with mercury, themercury extends the entire length of the
penetrometer. As increasing pressure causes themercury to intrude into the sample’s pores, the
volume of mercury in the penetrometer stem decreases by an amount equal to the volume of the
pores filled. This decrease in the length of the penetrometer stem that is filled with mercury causes a
reduction in the penetrometer capacitance. The analysis application convertsmeasurements of the
penetrometer capacitance into data points showing the volume of mercury intruding into the
sample’s pores.

Theory on page D - 1 provides a thorough discussion of the theory of porosimetry.

The BasicWorkflow
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1 Analyzer Components

SPECIFICATIONS FOR AUTOPORE IV

Characteristic Specification

Electrical

Frequency 50 to 60 Hz

Power 600 VAmaximum

Voltage 100/120/220/240 VAC ±10%

Gas

The gasmust be dry, clean, inert, and regulated to 60 psig.

High Pressure

Measurement

Model 9510/9520 From atmospheric pressure to 60,000 psia (414MPa)

Models 9500/9505 From atmospheric pressure to 33,000 psia (228MPa)

Pore Diameter Range

Model 9510/9520 6 to 0.003 µm

Models 9500/9505 6 to 0.005 µm

Resolution

Model 9510/9520 0.3 psi (2070 Pa) from 5000 psia (34MPa) to 60,000 psia
(414 MPa), and 0.1 psi (689 Pa) from atmospheric pressure to
5000 psia (34MPa)

Models 9500/9505 0.2 psi (1400 Pa) from 3000 psia (21MPa) to 33,000 psia

Transducer Accuracy ±0.1% of full scale (transducer manufacturer's specifications)

Intrusion

Accuracy ±1% of maximumpenetrometer stem volume

Resolution Better than 0.1 μL

Low Pressure

Measurement 0 to 50 psia (345 kPa)

Pore Diameter Range 3.6 µm to >900 µm

Resolution 0.01 psi (69 Pa)

Servo Control Precision 1% of target, min. .05 psia, no overshoot

Transducer Accuracy ±1% of full scale (transducer manufacturer’s specifications)
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Characteristic Specification

Penetrometers

Capillary Stem Intrusion
Volumes

0.38, 1.1, 1.7, 3.1, and 3.9 cc

Sample Size Maximum: a cylinder 2.54 cm diameter × 2.54 cm long (1 in. dia-
meter × 1 in. long)

Physical

Height 143 cm (56.25 in.)

Width 54.3 cm (21.38 in.)

Depth 78 cm (30.75 in.)

Weight 250 kg (550 lb)

Computer Requirements

l Operating System. Windows 7 Professional or higher operating system is recommended for
the best user experience.

l Desktop Installation Required. The application should not be installed on a network drive
with shared access. Multiple users cannot operate the application at the same time.

l 10 Base T or 100 Base T Ethernet Port. If the computer is to be connected to a network, two
Ethernet ports are required. If more than one Ethernet based unit is connected to the same com-
puter, an Ethernet switch will also be required.

l Read / Write Permissions. All users of the application will need Read/Write permission to all
directories and subdirectories where the application is installed.

l Drives.CD-ROMdrive and thumb drive.

In keeping with a policy of ongoing product improvement, specifications are subject to change
without notice.

Specifications for AutoPore IV
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2 ABOUT THE SOFTWARE

The analyzer allows other computer programs to run while an automatic operation is in progress.
TheHelpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into the predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its own
tab and reflects data collected during the analysis.

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the computer
must be used for that purpose.

TheSetup program is located on the installationmedia and is used to reinstall the software and
make analyzer changes— such as adding or removing a unit, etc.

If the IP address needs to be changed on the computer connected to the analyzer, refer
to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The default IP address is 192.168.77.100.

2 About the Software
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2 About the Software

SOFTWARE UPDATES
Log in to your customer portal to access and download the latest analyzer software version.

When performing a software update, existing data files are not overwritten. There are three types of
subsequent installation:

l a later version than the current installation
l the same version as the current installation
l an earlier version than the current installation

Insert the setupmedia into themedia drive. The setup program starts automatically. If the program
does not start automatically, navigate to the installationmedia drive, locate and double click the
setup.exe file.

UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed.
Parameter files, sample files, reports, calibration files, and data files are not removed.

To uninstall the software, double click the uninstall.EXE file located in the software installation
directory, then follow the screen prompts.

MENU STRUCTURE
All program functions use standardWindowsmenu functionality. The title bar contains aUnit
Number. If multiple units (analyzers) are installed, ensure the appropriate unit is selected before
continuing.

Option Description

File Use tomanage files used by the application— such as sample files, ana-
lysis conditions files, report options files, etc.

Unit [n] Use to perform analyses, calibrations, and other analyzer operations.Unit
[n] displays on themenu bar for each analyzer attached to the computer.

Reports Use to run reports and view the results.

Options Use to edit the default method, specify system configuration, specify units,
and change presentation options.

Window Use tomanage open windows and display a list of open windows. A check-
mark appears to the left of the active window.

Help Provides access to the online operator manual, theMicromeritics web
page, the analyzer web page, and information about the analyzer.

Main Menu Bar Options
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COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located inmultiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Field or Button Description

Add Add an item to the list.

Add Log Entry Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-
axes to be scaled automatically.Autoscalemeans that the x- and y-
rangeswill be set so that all the data is shown. If Autoscale is not selec-
ted, the entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code Enter bar code reader information if a bar code reader is connected to
the computer’s USB port. If a bar code reader is not used, this alpha-
numeric field can be used to enter additional information about the
sample, such as a sample lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window.

Close All Closes all active windows. If changesweremade and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments about the sample or analysis. Comments display in
the report header.

Copies Select the number of copies to print. This field is only enabled when
Print is selected.

Delete Whenworking with pressure tables and pressures,Delete removes
the selected information.

Destination Select the report destination.

Common Fields and Buttons Table

Common Fields and Buttons
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2 About the Software

Field or Button Description

Edit Whenworking with report parameters, highlight the item in theSelec-
ted Reports list box and clickEdit to modify the report details.

Exit Exits the application. If a file is open with unsaved changes, a prompt
displays providing the option to save the changes and exit or to exit the
application without saving the changes.

Export Exports data in a sample file as a .REP, .TXT or .XLS file. When saved
to a file, the data can be imported into other applications.

File Select the destination directory. Enter a new file name in the File name
field, or accept the default. Select to save the file as a report system
(.REP), a spreadsheet (.XLS), a portable document format (.PDF), or
an ASCII text (.TXT) file format.

File name Select a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file on the left.

From / To Whenworking with report parameters windows, enter the From and
To range for x- and/or y-axes.

Insert Use to insert one row above the selected row in the table.

List Creates a list of sample or other type files. The list will contain file
name, date / time the file was created or last edited, file identification
and file status.

Name column A list of files in the selected directory or library.

Next Click tomove to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double click the file name in the
Name column to open the file.

Prev Click tomove to the previouswindow.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer or file).

Remove Remove the selected file or files from the list.

Replace Click to select another file where the valueswill replace the current
file’s values.

Replace All Click to select another .SMP file where the valueswill replace all val-
ues for the active sample file. The original file will remain unchanged.

Common Fields and Buttons Table (continued)
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Field or Button Description

Report Click to display a window to specify report output options.

Save Saves changes to the active window.

Save As Saves a file in the active window under a different file name.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Use to display the data from the current analysis.

Instrument Log. Use to display recent analyses, calibrations, errors
or messages.

Instrument Schematic. Use to display a schematic of the analyzer
system.

Common Fields and Buttons Table (continued)

Common Fields and Buttons
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2 About the Software

FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION
In the File Selectorwindow, theMicDescription column and theMic Status column display file
description and file status. The File Selector incorporates standardWindows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display amenu of
standardWindows functions.

File Status Description

Analyzing Sample files that are currently being used for analysis.

HP Complete l A high pressure analysis has been performed using this sample
file.

l A low pressure analysismust be performed on a sample before
a high pressure analysis can be performed; files with the status
HP Complete have finished one low pressure analysis and at
least one high pressure analysis.

l Multiple high pressure analyses can be performed on a sample,
so files with the statusHP Completemay have finishedmore
than one high pressure analysis.

LP Complete A low pressure analysis has been performed using this sample file.
(Only one low pressure analysismay be performed on each file.)

No Analysis Sample files which have not been used to perform an analysis.

File Status and Description Table

File Type File Name
Extension

Default Location

Analysis Conditions .ANC ParamDirectory

Material Properties .MTP ParamDirectory

Methods .MTH ParamDirectory

Penetrometer .PEN ParamDirectory

Report Options .RPO ParamDirectory

Sample File .SMP Data Directory

File Type, Extension, and Location Table
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File types available when printing or exporting reports:

Portable document
format

.PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

File Status, Description, Extension, and Location
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2 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate somemenu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of themenu item.

Certain menus or functions can also be accessed using theAlt key plus the underlined letter in the
menu command. For example, to access the Filemenu, pressAlt + F, then press the underlined
letter on the submenu. For example,Alt + F opens the Filemenu, then pressO to access the File
Selector for opening files.

If the underscore does not display beneath the letter on themenu or window, press the
Alt key on the keyboard.

Field or Button Description

Alt +[Unit n] Opens the Unit [n]menu.

Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to save
changes displays.

Alt + H Opens theHelpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens theReportsmenu.

Alt + W Opens theWindowmenu.

Shift + F9 Opens the shortcut menu of (1) selected component on analyzer schematic
whenmanual control is enabled or (2) onscreen reports.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selector.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Displays the File Selectorwindow.

F3 When in the File Selectorwindow, opens the file search box.

F4 When in the File Selectorwindow, opens the address bar.

Keyboard Shortcut Table
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Field or Button Description

F6 Cascades open windows.

F7 Tiles open windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

Keyboard Shortcut Table (continued)

OPTION PRESENTATION
Options > Option Presentation
Use to change the way sample files and parameter files display:Advanced, Basic, orRestricted.
Each display option shows sample information and options differently.

Presentation Display Description

Advanced Displays all parts of sample information and parameter files. Navigate
to parameter windows by selecting the tabs across the top of the win-
dow.

Basic Displays sample information in a single window. This display option is
used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window similar to theBasic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same passwordmust be entered to
change to theBasic or Advanced display option. This display type is
typically used in laboratories where analysis conditionsmust remain
constant— such as the pharmaceutical industry. TheAdvanced option
is not available at the bottom of the window when using theRestricted
display option.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display Table

Specify or change the default option presentation by selectingOptions > Option
Presentation, or selectBasic or Advanced from the drop-down list at the bottom of the
window.

Option Presentation
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2 About the Software

The following examples show the same sample file inAdvanced andBasic display.Basic and
Restricted displayswill look the same.

A sample file must be created for each analysis. The file can be created prior to or at the
time of analysis. The sample file identifies the sample, guides the analysis, and specifies
report options.

2 - 10 AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017



LIBRARIES
Options > Manage Libraries

This feature is available only for Windows 7 and higher operating systems.

The library provides an easyway to locate and open specific analyzer files. Libraries are located
within the File Selectorwindow and can be viewed only within the application.

The library gathers sample and parameter files that are stored inmultiple locations— such as folders
on a C: drive, a network location, a connected external hard drive, or a connected USB flash drive—
providing access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items such as saved searches and search connectors
cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original file
storage location. However, when deleting files or folders fromwithin a library, they are deleted from
their original file storage location.

Libraries
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2 About the Software

METHODS

Options > Default Method

File > Open > [.MTH File]

See also:

Sample Files on page 3 - 1

AMethod determines the default sample identification format and sequence number. AMethod is a
template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed, so that only a single
selection is required for each new sample file created.

TheMethod drop-down list displays only thosemethods applicable to the open sample file type.
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CONFIGURE THE ANALYZER

ATMOSPHERIC PRESSURE

Options > Atmospheric Pressure
For accurate analysis, the applicationmust adjust pressuremeasurements to account for variations
in local atmospheric pressure (barometric pressure).

Enter the current atmospheric pressure or accept the system default of 14.7 psia (0.1014MPa).
When the port is open, it is recommended to enter the value on the low pressure display. It is
recommended to enter the current atmospheric pressure daily (or more frequently if atmospheric
pressure rises or falls rapidly during the day).

SelectDetermine high pressure transducer offset to enable the system to determine automatically
the high pressure transducer offset.

If the atmospheric pressure is above the entered value and theDetermine high pressure transducer
offset option is selected, a warning will display.

Configure the Analyzer
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2 About the Software

MEASURED TEMPERATURE WARNING

Options > Warnings
Enable this option to have the analyzer automatically display a warning if themeasured temperature
rises above the entered temperature.

SPECIFY UNIT SELECTIONS

Options > Units
Use to specify how data should appear on the application windows and reports. Thismenu option is
not available if usingRestricted option presentation.
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UNIT CONFIGURATION

Unit [n] > Unit Configuration
Use to display hardware / software configurations.

Field or Button Description

Calibration group box Displays the dates of the last high and low pressure servo calibrations
and signals.

Configuration group box Displays the IP address used by the analysis program, serial number,
and type of analyzer.

Change IP [button]. Displays theUnit IP Setupwindow. The IP
address and subnet mask assigned during installation display. Do not
edit these fields unless instructed by aMicromeritics service
representative.

Board ID [button]. Displays information from the electronic circuit
boards in the analyzer. These parameters cannot be edited.

Software Versions
group box

Displays the software versions of the controller start up code, analysis
program, and type of analyzer.

Unit Configuration Fields and Buttons Table

Unit Configuration
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2 About the Software

INSTRUMENT STATUS

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
To operate the valves and elevator from the schematic, manual control must be enabled (Unit [n] >
Enable Manual Control).

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve.

Servo Valve. Closed.

Servo Valve. Open.

Analyzer Schematic Icon Table
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Mercury Degasser. Displays themercury level.

Drained Partially Filled Filled Overfilled. This alarm
displays

with a red background.
This is an alarm state.

Mercury Trap.Displays the state of themercury trap.

Empty Containsmore than 6mmof mercury.
This is an alarm state.

Mercury Reservoir.Displays the level of mercury in the reservoir.

If themercury level is low, seeMaintain Mer-
cury Level on page 11 - 17.

Level is OK.

Low Pressure Schematic Icons

Show Instrument Schematic

AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017 2 - 17



2 About the Software

Hydraulic Pump
When the pump is operating, the target pressure
displays below the icon. A green icon indicates the
pump isON. A yellow icon indicates the pump is
OFF. To set the target pressure when the icon is
yellow, either double-click the pump icon or right
click the icon and selectSet.

Intensifier. Displays the state of the intensifier limit switches.

Midway Top Bottom

High Pressure Schematic

Instrument Schematic Shortcut Menus

Eachmanually controlled schematic component has a shortcut menu displaying the operations
available for that particular component. To access the shortcut menu, hover themouse pointer over
the component and right click.

Schematic Shortcut
Icon

Available Options:

Valve options Automatic.Automatically operates the servo valve during dosing or
evacuation. Enter the target pressure.

Close.Closes the selected valve.

Disable. Select to disable the servo pump. To enable the pump, right
click the servo pump icon and selectSet to verify or set a target
temperature. When the pump is enabled, the target temperature
displays below the servo pump icon.

Open.Opens the selected valve.

Pulse.Use to quickly turn the valve on and off allowing the operation
to proceed in small increments.

Set.Use to set the servo pump target pressure.

Schematic Shortcuts Table
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SHOW STATUS

Unit [n] > Show Status

SHOW DASHBOARD

Unit [n] > Show Dashboard
The dashboard displays the following:

l Number of days until low pressure system service is due
l Days until high pressure system service is due
l Days until Hg filter replacement is due
l Low pressuremanifold outgas rate
l Hg temperature (°C) mean ±2σ, min/max
l High pressure cycles completed
l Low pressure analyses completed / started
l High pressure analyses completed / started

Data for the dashboard comes from the logged diagnostic data. The dashboard is automatically kept
current as the relevant diagnostic data items are updated. The gaugeswill be updated even if the
dashboard window is not open.

Red numbers on the dashboard require attention. To reset the dashboard numbers,
right click on the dashboard setting, then clickReset.

Show Status
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2 About the Software

Field or Button Description

Days until high pres-
sure system service is
due

The number of days until service is required on the high pressure sys-
tem.When the displayed value is 30 or less, the value is displayed in
red. Red negative numbers display if maintenance is past due.

Days until Hg filter
replacement is due

The number of days until themercury filter replacement is due.When
the displayed value is 30 or less, the value is displayed in red. Red neg-
ative numbers display if maintenance is past due.

Days until low pressure
system service is due

The number of days until service is required on the low pressure sys-
tem.When the displayed value is 30 or less, the value is displayed in
red. Red negative numbers display if maintenance is past due.

Hg temperature Displays the statistics of themanifold temperature reading. Themean,
the value at two standard deviations, theminimum, and themaximum
display.

High pressure analyses
completed / started

DisplaysN/Mwhere N is the number of high pressure analyses that
have finished data collection andM is the number of analyses that
have been started. Analyses canceled or terminated by errors before
the termination stage starts are not counted as completed.

High pressure cycles
completed

Indicates the number of completed high pressure cycles. Cycles can-
celed or terminated by errors before the termination stage starts are
not counted as completed.

Low pressure analyses
completed / started

DisplaysN/Mwhere N is the number of low pressure analyses that
have finished data collection andM is the number of analyses that
have been started. Analyses canceled or terminated by errors before
the termination stage starts are not counted as completed.

Low pressure manifold
outgas rate

Provides the qualitative indication of the outgas rate in the dosing
manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

l Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

l At 30%, the left LED turns off.
l At 60%, the center LED turns off.
l At 90%, three green LED lights turn off and the center yellow LED is
turned on.

l At 110% and above, only the red LED is lit and attention is required.

Dashboard Gauges and Descriptions Table
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SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log
Use to display a log of recent analyses, calibrations, errors, or messages. The log displays:

l 7 days of analysis data
l 30 days of messages
l 30 days of calibration data

Field or Button Description

Add Log Entry Tomanually enter information into the log file, enter the text into the
text field to the left of theAdd Log Entry button, then clickAdd Log
Entry.

Analysis /
Calibration /
Message /
Conductivity

Select the logs to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Instrument Log Fields and Buttons Table

Show Instrument Log
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2 About the Software

EXPORT FILES
File > Export

See also:

Exported Data Example on page G - 1

Provides the option to print the contents of one or more sample files to either the screen, a printer, or
to a file. Intrusion data can be exported as a .PDF, .REP, .TXT, or .XLS file format. The type of data
to include or exclude can be selected during the export process.When exported to a file, the data
can be imported into other software that read .TXT or .XLS file formats.

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the file
was created or last edited, file identification, and file status.
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3 ABOUT SAMPLE FILES
Sample files include the information required by the analyzer to perform analyses and collect data. A
sample file identifies the sample, guides the analysis, and specifies report options andmay be
displayed in either Advanced, Basic, orRestricted presentation displaymode.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

The analysis software contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

Specify or change the default option presentation by selectingOptions > Option
Presentation, or selectBasic or Advanced from the drop-down list at the bottom of the
window.

SAMPLE FILES
Options > Option Presentation > [Advanced / Basic / Restricted]

File > Open > [.SMP File]
Each analysismust be linked with a sample file before the analysis can proceed.

Specify or change the default display option by selectingOptions > Option Presentation or select
Basic / Advanced from the drop-down list at the bottom of the window.

The values for individual parameters in a file must be initially entered in Advancedmode and the file
saved. Sample files can then be created in Advanced, Basic, or Restrictedmode by selecting
predefinedMethods or Analysis Conditions and Report Options.

The values specified in the parameter portions of the default sample file are saved as the defaults for
new sample files. To navigate from one set of parameters to another, select the parameter tab
across the top of the window.

3 About Sample Files
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3 About Sample Files

Field or Button Description

Assembly mass
[text box]

This field is entered after the low pressure analysis is completed.
Sample + penetrometer + mercurymass after the low pressure ana-
lysis.

Bar Code Enter bar code reader information if a bar code reader is connected to
the computer’s USB port. If a bar code reader is not used, this
alphanumeric field can be used to enter additional information about
the sample, such as a sample lot number, sample ID, etc. To rename
the field label, go toOptions > Default Method and deselect the
Omit option.

Comments [text box] Enter comments about the sample or analysis. Comments display in
the report header.

Material [drop-down box] Select thematerial to be analyzed from the drop-down list. SeeMater-
ial Properties on page 4 - 7.

Method [drop-down box] Select amethod from the drop-down list. SeeMethods on page 2 -
12.

Operator [text box] Enter operator identification information. This field label may have
been renamed or may not display if modified inOptions > Default
Methods.

Penetrometer
[drop-down box]

Select a penetrometer file from the drop-down list, or clickEdit to
modify or create a new Penetrometer file. SeePenetrometer Prop-
erties on page 4 - 9.

Sample [text box] Enter a sample description.

Submitter [text box] Enter submitter identification information. This text boxmay have been
renamed or may not display if modified inOptions > Default Meth-
ods.

Sample File Fields and Buttons Table
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Field or Button Description

Type of Data [group box] Automatically collected.Select if the type of data will be
automatically collected by the systemwhile an analysis is running.

Manually entered.Use to enter datamanually that was collected
from another source. IfManually entered is selected, the Intrusion
Report becomes available in theBasic/Advanced drop-down list for
pasting or importing data into the file.

SeeManually Enter Data on page 3 - 8.
User Parameters
[group box]

These fields are primarily used for the SPC (Statistical Process
Control) reporting to specify sample characteristics or its
manufacturing process but may be used for other data by entering
specific analysis conditions or sample criteria.

The entered parameters display on theSummaryReport. Some fields
may not display (or may have a different field label) if modified in the
method fromwhich the sample file was created, either through
Options > Default Method or File > Open > Method.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Sample File Fields and Buttons Table (continued)

Sample Files
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3 About Sample Files

OPEN A SAMPLE FILE
File > Open > [.SMP File]

Whenworking with an existing sample file, consider making a copy of the sample file to
maintain the original configuration options.

File Type File Status Displays

Mercury Porosimetry

Analyzing
Entered
No analysis

Tabbed file editor

HP Complete
LP Complete Report window
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SAMPLE AVERAGING
File > Average
A sample file can be created in which the collected data are the average of up to four similar
analyses. All information in the new sample file will be the same as in the first selected file except for
the information entered in theSample Averagingwindow. The collected data in the file will be the
average of the data in the selected files.

Sample averaging can be used for sample files and blank correction files.

BASELINE ERROR CORRECTION METHODS

The penetrometer parts, themercury, and the sample are all affected differently by the pressures
exerted on them during analysis. Eachmaterial compresses to a different degree and at a different
rate. Also, the increasing pressure within the high pressure port can cause the temperature of one or
more of thesematerials to rise.

As a result, analysis datamay show intrusion where none actually exists. For example, if the sample
compresses sharply at a given pressure (compared to the compression of themercury at that
pressure), mercurymoves from the penetrometer stem into the sample bulb to fill the space vacated
by the shrinking sample. This reduction in the amount of mercury in the stem is interpreted by the
software as intrusion.

These baseline errors can be reduced or eliminated through one of two correctionmethods:

l formula correction, and
l blank correction

The correctionmethod is selected in thePenetrometer Properties file and displays in theSample file.

Sample Averaging
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3 About Sample Files

CREATE BLANK CORRECTION FILE

File > Open > [enter new .SMP file name]
A sample file must be created even if there is no sample or if the sample is non-porous.

A blank correction file contains analysis data using one of the following:

l Mercury only (a blank run)
l A nonporous sample of the samemass andmaterial as the samples to be analyzed

To be used as a correction file, the blank run should use the same analysis conditions
and penetrometer properties as the sample analysis. Therefore, a separate blank cor-
rection file should be created for each type of sample and set of analysis conditions to be
used.

Nomatter which type of blank correction run is used, the procedure is the same (follow the
instructions for creating a sample file (even if there’s no sample), then run the analysis. (When the
blank file’s sample file is created, selectNone for correctionmethod.)

1. Create the sample file. Enter zero for the samplemass.
2. Perform the low and high pressure analysis. SeePerform a Low Pressure Analysis on

page 5 - 11 andPerform a High Pressure Analysis on page 5 - 16.

An alternativemethod for creating the blank correction file is to perform aHigh Pressure
Differential analysis which analyzes the blank and sample simultaneously. SeePerform
a High Pressure Analysis on page 5 - 16.
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FORMULA CORRECTION

A formula for correction is available for each type of penetrometer. The formula is a part of the
application software, therefore when the Formula option in thePenetrometer Properties file is
selected, the formula is applied.

The recommendedmethod of correction is by blank correction file. The formula is provided for use
when comparison with historical data is required.

COMBINE A PENETROMETER CALIBRATION AND BLANK CORRECTION FILE

1. After the low pressure run, do not empty the penetrometer. Weigh it and record the assembly
mass. Use a syringe to withdraw a small amount of mercury from the tip of the capillary so that
themercury column recedes approximately 1/8 in. to 1/4 in. into the stem. This enablesmeas-
urement of any rise or fall of mercury in the stem during high pressure analysis and prevents
spilling of mercury into the high pressure chamber. Then install the penetrometer in a high
pressure port.

2. Create blank correction files by completing the high pressure run. SeeCreate Blank Cor-
rection File on the previous page.

3. Create a new Penetrometer Properties file for this penetrometer. SeePenetrometer Prop-
erties on page 4 - 9. From the file selection list, choose the default file for this type of pen-
etrometer. Change the identifier to include the penetrometer serial number. Enter the
calibrated volume and save the file. ThePenetrometer Properties file now includes the cal-
ibrated penetrometer volume. A blank correction file has also been created for this pen-
etrometer.

Formula Correction
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3 About Sample Files

MANUALLY ENTER DATA
This process allows themanual entry of pressure data from a sample file with aComplete status.
There are twomethods for manually entering data into a sample file:

l Copy and paste onto the graph area of the interactive window
l Import data into the interactive window

COPY AND PASTE MANUALLY ENTERED DATA
1. Open a sample file with aComplete status. The file will open to the interactive reports window.
2. Right click in the graph area of the interactive reports window, then selectCopy data.

3. Open another sample file usingAdvanced option presentation.
4. On theSample Description tab, selectManually entered in the Type of Data group box.
5. Click theAdvanced down arrow at the bottom of the window, then select Intrusion .
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6. Ensure that all parameter fields are set appropriately, then click thePaste button.

Manually Enter Data
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3 About Sample Files

IMPORT MANUALLY ENTERED DATA
When importing isotherm data from an external ASCII text file using the Import button on the
interactive window, the ASCII text file must use the following rules:

ASCII text file format rules

Datamust be in two columns and separated by a comma or white-space. Acceptable column
headings are:

l Pressure (psi)
l Pressure (MPa)
l Pressure (kPa)
l Pressure (Pa)
l Pressure (bar)
l Pressure (mbar)
l Pressure (Atm)

l Intrusion (cm3)
l Intrusion (cm3)
l Intrusion (ml)
l Intrusion (mm3)
l Intrusion (mm3)

Sample Mercury Porosimetry ASCII Text File

Cumulative Intrusion for Cycle 1
Pressure (MPa) Cumulative Intrusion (cm³/g)
0.138151 0.0
0.155414 0.00637965
0.310025 0.0327685
0.458529 0.0377315
0.816881 0.0411021
1.46145 0.0427142
2.60941 0.0444728
4.00728 0.0460848
5.35594 0.0474771
7.24049 0.0495286
9.63008 0.0519466
13.7208 0.0561233
24.4012 0.0808897
46.6833 0.800216
83.4181 1.15068
159.718 1.1586
286.294 1.16834
412.525 1.17574
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To import the ASCII text file

1. Open a new sample file inAdvanced option presentation.
2. On theSample Description tab, selectManually entered.
3. Click theAdvanced down arrow at the bottom of the window, then select Intrusion..

4. Ensure that all parameter fields are set appropriately, then click Import.
5. Open the .TXT file. The data from the original sample file is imported and displayed. If an error

message appears instead, verify that the .TXT file format is correct.

Manually Enter Data
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4 ABOUT PARAMETER FILES
Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

Methods include both analysis conditions and report options, offering themost convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed or new
parameter files can be created.

The following file types can exist as part of the sample file aswell as individual parameter files:

File Type File Extension

Analysis Conditions .ANC

Material Properties .MTP

Method .MTH

Penetrometer Properties .PEN

Report Options .RPO

4 About Parameter Files
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4 About Parameter Files

ANALYSIS CONDITIONS
File > Open > [.ANC File]
(or click theAnalysis Conditions tab when inAdvanced option presentation)

Analysis conditions specify the parameters used to guide an analysis.

Button Use to Specify...

High Pressure
[group box]

Equilibrate by. Select the option for equilibration based on elapsed
Time (in seconds) or decrease inRate of intrusion (or extrusion) in
mL/g per second.

Scan by:

l Pressure. The analyzer goes through a sequence of segments,
with each segment starting at the end of the previous one. Each
segment ends at the specified pressure. The pressure is pro-
grammed to increase or decrease at a rate to give a constant time
per decade of pressure. Along the way, the analyzer takes intrusion
points at the specified number of points per decade, ending at the
specified ending pressure. Also, any points in the pressure table, as
well as points separated by themaximum intrusion volume, are col-
lected.

l Intrusion. The analyzer goes through a sequence of segments,
with each segment starting at the end of the previous one. Each
segment ends at the specified pressure The pressure rate is the
maximumachievable safe rate (up to 0.5min/decade) and is pro-

Analysis Conditions Fields and Buttons Table
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Button Use to Specify...

grammed to increase or decrease at a rate to give a constant intru-
sion / extrusion rate. The analyzer takes intrusion points at the spe-
cified number of points per decade, ending at the specified ending
pressure. Also collected are points in the pressure table, as well as
points separated by themaximum intrusion volume.

If both high pressure ports are in use, theymay have different
intrusion rates. In this case, the left port (port 1) determineswhen
data are collected. The right port collects data at the same times as
the left. This allows a differential analysis to be performed in this
mode.

l Hold at maximum pressure.Enter additional amount of time to
remain at themaximumpressure in a pressure table intrusion seg-
ment before beginning extrusion.

Low Pressure
[group box]

Evacuation . Select if the sample is a Formed solid, Powder, or
Other. IfOther is selected, the remaining fields are enabled. This
window is also available fromUnit [n] > Evacuate Low Pressure.

l Initially evacuate at. Enter the initial maximumevacuation rate.
l Switch to medium at. Enter themethod and pressure the system
must reach beforemedium evacuation begins.
o Use pressure transducer
o User vacuum gauge

Analysis Conditions Fields and Buttons Table (continued)

Analysis Conditions
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4 About Parameter Files

Button Use to Specify...

o Skipmedium evacuation

l Switch to fast at. Enter the pressure the systemmust reach
before fast evacuation begins.

l Evacuation target.Enter the evacuation pressure.
l Continue evacuating for. Enter the evacuation duration.

Filling pressure. The penetrometer is filled with mercury at this
pressure. It is recommended to set the filling pressure slightly lower
than the first low pressure point on the pressure table.

A filling pressure of at least 0.5 psia is recommended.
Becausemercury generates pressure and because fill
pressures less than 0.5 psia can fail to fill the corner radii
and gaps between the glass and sample in the pen-
etrometer, using a lower pressuresmay reduce the accur-
acy of data.

If the filling pressure is higher than any point in the table,
an error message occurs. Delete the pressures lower
than the filling pressure or change the filling pressure.

Equilibrate by. Select the option for equilibration based on elapsed
Time (in seconds) or decrease inRate of intrusion (or extrusion) in
mL/g per second.

Mercury [button] Enter themercury properties. Mercury propertiesmay change with
variations in temperature.

Advancing contact angle.Enter the advancing (intrusion) contact
angle.

Analysis Conditions Fields and Buttons Table (continued)
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Button Use to Specify...
Receding contact angle. Enter the receding (extrusion) contact
angle.

Surface tension. Enter the surface tension of mercury.

Enter Hg Density. Select to manually enter a density.

Linear compressibility. Enter the linear compressibility coefficient.

Quadratic compressibility. Enter the quadratic compressibility
coefficient.

Table Options Last Low Pressure. Select the row to indicate the last low pressure.

Starting Pressure. This column is not editable. The data are taken
from theEnding Pressure of the preceding row and the Filling
Pressure for the first row.

Pressure Increment. Enter the pressure increment for this segment
if a sequence of linearly spaced pressures is preferred. Either the
Pressure Increment or Points Per Decade can be specified. If one is
entered, the other is automatically set to zero and displayed as blank.
By default, both columns are blank (zero) when a new row is inserted
or appended. If both columns are blank, only theEnding Pressurewill
be used.

Points per Decade.Enter the number of points per decade for this
segment if a sequence of logarithmically spaced pressures is
preferred. Either thePressure Increment or Points Per Decade (but
not both) can be specified. If one is entered, the other is automatically
set to zero and displayed as blank. By default, both columns are blank
(zero) when a new row is inserted or appended.

Ending Pressure. Enter the ending pressure for this segment.

Maximum Intrusion. The analyzer automatically takes additional
readings between points on the pressure table when this volume of
additional intrusion is detected. Enter the intrusion volume per gram of
sample that must be reached in order for additional data pair readings
to be recorded. Use 0 to prevent readings between pressure points.
SeeUse of the Maximum Intrusion Volume Option on page E -
1. TheMaximum Intrusion entry is set to the same value as the
preceding row by default when a new row is inserted or appended.

Analysis Conditions Fields and Buttons Table (continued)

Analysis Conditions
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4 About Parameter Files

Button Use to Specify...
Scan Rate. If scanning by pressure, enter theminutes per decade for
this segment. If scanning by intrusion, enter the intrusion rate for this
segment. TheScan Rate column is set to blank (zero) and disabled for
all rows up to and including the Last Low Pressure. If Scan By
Pressure or Intrusion is selected, the column title will display the
appropriate units (min/decade) or (mL/g-sec) and each high pressure
row must contain a value. The value for the previous row is set by
default when a new row is inserted or appended, or the default value
(5min/decade or 0.001mL/g-sec) for the first high pressure row.

Insert Range. Click to display theEnter Pressure Rangewindow for
entering parameters for the system to autofill the table with starting
pressure, ending pressure, and the number of points to insert within
the specified range.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Analysis Conditions Fields and Buttons Table (continued)

4 - 6 AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017



MATERIAL PROPERTIES
File > Open > [.MTP File]
Material properties specify the properties of thematerial to be used in an analysis. This information is
only required if it is to be used in a report. SeeReport Options on page 4 - 10.

Field or Button Description

BET Surface Area
[text box]

Enter the BET surface area.

Linear compressibility
[text box]

Enter the linear compressibility coefficient.

Quadratic com-
pressibility [text box]

Enter the quadratic compressibility coefficient.

Use entered con-
ductivity formation
factor... [check box]

Select if using the entered conductivity formation factor for per-
meability calculations and enter the factor in the text box.

Use entered density
[check box]

Select if using the entered density and enter the bulk and /or true
density in the appropriate text boxes. The entered values are used in
the intrusion summary results, Mayer-Store report, and the pore
structure report. TheMayer-Stowe particle size calculation has
meaningmostly in the range of interstitial filling. For larger pressures
after which the interstitial space is filled, the particle size calculation
has lessmeaning.

Material Properties Fields and Buttons Table

Material Properties
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4 About Parameter Files

Field or Button Description

Use entered threshold
pressure [check box]

Select if using the entered threshold pressure and enter the threshold
pressure in the text box.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Material Properties Fields and Buttons Table (continued)
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PENETROMETER PROPERTIES
File > Open > [.PEN File]
Penetrometer properties specify the properties of the penetrometer to be used in an analysis.

Field or Button Description

Maximum head pres-
sure [text box]

Enter themaximumhead pressure. SeeSelect a Penetrometer on
page 5 - 1.

Constant [text box] Enter the penetrometer constant provided with the penetrometer.
Verify the field contents if theReplace option has been used.

Correction Method
[selection]

Blank. If using the blank correctionmethod, clickBrowse to select a
sample file. SeeCreate Blank Correction File on page 3 - 6.

Formula.See Formula Correction on page 3 - 7.

None.
Mass [text box] Mass of the empty, assembled penetrometer (excluding the spacer).

Penetrometer
[drop-down box]

Enter identifying information for this file.

Stem volume [text box] Enter the penetrometer stem volume provided with the penetrometer.

Volume [text box] Enter the volume of the penetrometer. This is required to calculate
density or when using the blank correction formula.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Penetrometer Properties Fields and Buttons Table

Penetrometer Properties
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4 About Parameter Files

REPORT OPTIONS

File > Open > [.RPO File]
(or click theReport Options tab when inAdvanced format)

Use to specify report options for data collected from an analysis or manually entered data.Report
Options files also help in customizing report details such as axis scale, axis range, and column
headings. These filesmay contain tabular reports, plots, or both, as well as user-defined report
tables.

Customized report options files can be created then loaded into a sample file, allowing quick and
easy generation of reports.

Report Options filesmay be defined to include overlay options. This system allows the overlay of up
to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a different
plot type from the same analysis. SeeOverlay Multiple Mercury Porosimetry Graph Options
on page 6 - 23.

Field or Button Description

Edit [button] Edit graph options.

Plot Points.Select to plot points on the graph.

Plot Curve.Select to plot curves on the graph.

Show Histogram.Select to show the graph as a histogram.When
selected, thePlot Points andPlot Curve selections are disabled.

Report Options Fields and Buttons Table
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Field or Button Description

Header Options [button]

Show report title. Enter a report title to appear on the report header.

Show bitmap. Displays the selected graphic on the report header.

Height / Width.Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Report Options Fields and Buttons Table (continued)

Report Options
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4 About Parameter Files

Field or Button Description

Intrusion Data Options
[button]

This button is also located on Intrusion reports.

Report negative intrusion.Select to report small incorrect polarities
(negative intrusions or positive extrusions) whichmay indicate the
presence of noise, improper blank correction, or analyzer malfunction.

Select Data Included in Intrusion Reports. Enter range of
pressure. This range applies to the first twelve reports on the options
list. When these selections are changed in the intrustion report, the
lower right graph x-axis and the intrusion data in the graph will change
accordingly. The two blue range bars can then be used to select the
required range of data.

l Pressure. The default behavior of the application is to select data
using pressure as this is the quantity which is varied duringmercury
porosimetry analysis. Themaximal range of data (all data) is selec-
ted by default. It is advisable to use this default setting unless there
is a specific goal is required.

l Pore size.Uses theWashburn equation to translate the user
entered pore size range to a corresponding pressure range used for
data selection.

l Particle size.This option is less commonly used. In theMaterial
Propertieswindow, select the checkboxUse entered density and
complete theBulk density and effectiveParticle density fields. See
Material Properties on page 4 - 7. The effectiveParticle density
andBulk density quantities are necessary to compute the interstitial
porosity of the powder used in theMayer-Stowe calculation.

Report Options Fields and Buttons Table (continued)
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Field or Button Description
Smooth differentials.Select to apply smoothing to any differentials
reported in tables or graphs.

Use coefficients from compressibility report.Select to have the
application use the coefficients from theMaterial Compressibility
report rather than from theMaterial Properties.

Use material properties.Select to have the application use the
parameters fromMaterial Properties rather than from theMaterial
Compressibility report.

Overlays [button] Select the files to overlay.

Reference [button] Select a sample file to compare analysis results with the current
sample.

Selected Reports
[check box]

Select the report names to include in the report.

Report Options Fields and Buttons Table (continued)

Report Options
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4 About Parameter Files

Field or Button Description

Specification [button] Selects the sample files to be used for the boundaries of the coarse
and fine specifications. This helps in determining if the results of the
current sample are within the specified boundaries.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Report Options Fields and Buttons Table (continued)

4 - 14 AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017



5 PERFORM AN ANALYSIS
A low pressure analysismust be performed on a sample before a high pressure analysis can be
performed.

SELECT A PENETROMETER
Selecting themost appropriate penetrometer with which to test a particular material depends on
sample form or shape, sample porosity, and the quantity of sample.

Penetrometers are available with three sample volumes, with five intrusion capacities, and in
configurations for either solid pieces or powders. Refer to thePenetrometer Selection Guide in this
section.

Ensure the sample nearlymatches the size of the sample bulb and that the capillary volume is large
enough to satisfy intrusion.

Bulb
Volume
(cc)

Sample
Type

Maximum
Measurable
Volume
(cc)

Total
Stem
Volume
(cc)

Maximum
Head

Pressure
Physical Dimensions Part

Number
(psia) (kPa) I (mm) H (mm) D (mm)

3 Solid 0.387 0.412 4.68 32.3 227 242 1.473 950-61713-00

3 Solid 1.116 1.190 4.68 32.3 227 242 2.502 950-61715-00

3 Powder 0.387 0.412 4.68 32.3 227 242 1.473 950-61714-00
3 Powder 1.116 1.190 4.68 32.3 227 242 2.502 950-61716-00
5 Solid 0.366 0.392 4.45 30.7 215 230 1.473 950-61707-00

5 Solid 1.057 1.131 4.45 30.7 215 230 2.502 950-61709-00

5 Solid 1.716 1.836 4.45 30.7 215 230 3.188 950-61711-00

Penetrometer Selection Guide

5 Perform an Analysis
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5 Perform an Analysis

Bulb
Volume
(cc)

Sample
Type

Maximum
Measurable
Volume
(cc)

Total
Stem
Volume
(cc)

Maximum
Head

Pressure
Physical Dimensions Part

Number
(psia) (kPa) I (mm) H (mm) D (mm)

5 Powder 0.366 0.392 4.45 30.7 215 230 1.473 950-61708-00
5 Powder 1.057 1.131 4.45 30.7 215 230 2.502 950-61710-00
5 Powder 1.716 1.836 4.45 30.7 215 230 3.188 950-61712-00
15 Solid 0.366 0.392 4.45 30.7 215 230 1.473 950-61701-00

15 Solid 1.057 1.131 4.45 30.7 215 230 2.502 950-61703-00

15 Solid 1.716 1.836 4.45 30.7 215 230 3.188 950-61705-00

15* Solid 3.007 (3.263) 4.45 30.7 215 230 4.813 950-61724-00

15* Solid 3.857 (4.185) 4.45 30.7 215 230 4.813 950-61725-00

15 Powder 0.366 0.392 4.45 30.7 215 230 1.473 950-61702-00
15 Powder 1.057 1.131 4.45 30.7 215 230 2.502 950-61704-00
15 Powder 1.716 1.836 4.45 30.7 215 230 3.188 950-61706-00

Penetrometer Selection Guide (continued)

* The first 3 mmof stem on these penetrometers have an inside diameter (D) of 1.5mm. In
computingmaximummeasurable (intrusion) volume, the value of I should be reduced by 3mm.

l Maximummeasurable volume = [(3.14)(D2)(I)/4] × [0.001
cm3/mm3]

l Total Stem (Capillary) volume = [(3.14)(D2)(H)/4] × [0.001
cm3/mm3]

l MaximumHead Pressure (psia) = [H] × [0.01934 psia/mmHg]
l MaximumHead Pressure (MPa) = [H] × [0.000133MPa/mmHg]

A powder penetrometer should be used when the sample consists of small grains or particles.
Chunks of material or formed objects (maximum size is 25mmOD × 25mm long) should only be
installed in a “solid” penetrometer.
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Best results, generally, are obtained when the bulb of the selected penetrometer is nearly filled by
theminimumamount of sample that is representative. Next, the estimated pore volume of the
sample should not exceed 90% nor be less than 25% of the total stem volume (see column 4 of the
Penetrometer Selection Guide). Oncematerials of similar characteristics have been tested, it will
usually be possible to select the optimum penetrometer almost without fail.

As an example, suppose the sample consists of a single sintered pellet of nickel (density 8.9 g/cc)
weighing 29 g and having an estimated pore volume of 20% of the true sample volume to analyze.
The following characteristics are calculated:

Volume of sample = mass/density = (29g)/(8.9g/cc) = 3.26 cc

Approximate pore volume = fractional pore volume × sample volume =
0.20 (3.26 cc) = 0.652 cc

Approximate total volume = volume of pores + volume of sample
(3.26 + 0.652) cc = 3.91 cc

Hence, the penetrometer listed sixth in the Penetrometer Selection Guide as solid, 5 cc sample
volume, 1.131 cc total stem volumewould be the appropriate choice unless the pellet shape dictates
use of a larger one. The percent of maximummeasurable intrusion volume required by this sample is
(0.652 cc/1.131 cc) × 100% = 58%, which falls below the suggested 90%maximum.

The penetrometer for powdered or granular materials is chosen similarly, but remember that the
spaces among thematerial grains are likely to constitute a void of about 40%. As another example,
assume that 15 g of a granular material (density 3.5 g/cc) had been determined theminimum
quantity for representation. Assume the powder has low porosity: 3%.

Volume of sample = mass/density = (15 g)/(3.5 g/cc) = 4.29 cc

Approximate pore volume of material = fractional porosity x sample volume =
0.03 (4.29 cc) = 0.13 cc

Approximate volume of interstice = (4.29 cc + 0.13 cc) (40/60) = 2.95 cc

Total volume of powdered sample = 4.29 cc + 0.13 cc + 2.95 cc = 7.37 cc

Three powder penetrometers listed in the Penetrometer Selection Guide will contain 7.37 cc of
sample. Considering the sample size, the one having a total stem volume of 0.392 cc ismost
appropriate. The sample requires approximately 33% [0.13/0.39] of the stem capacity of the
penetrometer. Optimum performance would be achieved if, instead of merely using theminimum15
g of sample, the penetrometer were filled to capacity, which is approximately 30.5 g [15 × 15/7.37].
The penetration volumewould then be about 0.26 cc [0.13 × 15/7.37] or nearly 66% [0.26/0.39] of
the total stem volume.

Select a Penetrometer
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5 Perform an Analysis

The previous calculations assume that all interstitial volumewill be filled with mercury at
the filling pressure. A minimum fill pressure of 0.5 psia will fill cavities of approximately
500mmdiameter, whereas a filling pressure of 1.5 psia will fill cavities as small as 120
mmdiameter. If some interstitial volume remains unfilled at this point, allowance for this
additional volumemust bemade in choosing the appropriate stem volume.

The percentage of themaximum intrusion (stem) volume utilized in each station is displayed on the
StatusDisplay as a guide for the operator. A %STEM reading of less than 25% or more than 90%
suggests the need for a procedural change. The first instance suggests a larger quantity of sample
might give better resolution and the second indicates that the capillary is on the verge of being
depleted.
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PREPARE THE SAMPLE
To achieve gains in productivity and reduction in analyzer maintenance, aswell as improved data
quality, dry the samplematerial in a shallow pan at 150 ºC or higher for one hour. A vacuum oven
may be used, although it is not necessary to do so. Use of a vacuum oven is particularly beneficial if
the oven is backfilled with dry nitrogen prior to opening. Once the sample is dried, minimize any re-
exposure to the atmosphere.

The drying of samples prior to analysis is important, especially for sample types such as fluid
cracking catalysts, porous silicas, porous aluminas, and zeolites, which are almost impossible to
evacuate without fluidization unless first dried.

The preparation process consists of:

1. Clean the Penetrometer below
2. Load the Sample on the next page
3. Seal the Penetrometer on page 5 - 7
4. Weigh the Assembled Penetrometer with Sample on page 5 - 9
5. Install the Penetrometer on page 5 - 10

CLEAN THE PENETROMETER

Clean, dry penetrometers are essential for accurate, reproducible results.

It is recommended that rubber gloves be worn when handling penetrometers.

Never use an ultrasonic bath to clean penetrometers. Ultrasonic cleaning systemswill
damage themetal plating and remove the serial number information.

1. Dissolve Alconox® (or other suitable detergent) in water. Ensure the detergent is completely
dissolved before placing the penetrometer into the solution.

2. Place themercury waste container in a shallow pan of water in case of spills.
3. Hold the penetrometer upright over amercury waste container to allow any accumulatedmer-

cury to drain out.
4. Remove the cap from the penetrometer If the cap is difficult to remove, see Penetrometer

Nut on page 11 - 34.
5. Turn the penetrometer over and pour remaining sample into the waste container.
6. Immerse the penetrometer in the detergent solution. Clean the outside of the penetrometer

stem and the bulb with a brush. Then clean the inside of the stemwith one of the smaller
brushes.

Prepare the Sample
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5 Perform an Analysis

7. Rinse the penetrometer with warmwater. Hold the penetrometer upright and enure that water
runs from the bulb through the stem freely.

8. Rinse the penetrometer with IPA.
9. Immerse the stainless steel cap and nylon closure components in the detergent solution.

Clean with appropriate brushes and rinse in warmwater.
10. If there is anymercury in the bottom of the detergent solution, dispose of the solution properly.
11. Use dry nitrogen to dry the penetrometer, cap, and closure components.

LOAD THE SAMPLE

To avoid transferring skin oils, it is recommended to wear latex gloveswhen handling
penetrometers. Skin oilsmay affect results.

1. Enter the sample file name (or identifier) on theSample Data Worksheet on page F - 6.
2. Weigh the sample using an analytical balance. Record themass on the data sheet asSample

mass.
3. Hold the penetrometer with the stem down and carefully pour the sample into the bulb.

When pouring powders into the bulb, place a finger over the stem opening in the center of the
bulb so that powder does not enter the stem. A small funnel is useful for loading powders.
Large granules or chunksmay be loaded with forceps.
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SEAL THE PENETROMETER

To avoid transferring skin oils, it is recommended to wear latex gloveswhen handling
penetrometers. Skin oilsmay affect results.

It is important that penetrometers are clean and dry. SeeClean the Penetrometer on page 5 - 5.

1. A vacuum-tight seal is required. Therefore, vacuum grease (Apiezon H) must be used to fill
the inevitable roughness of the ground glass lip and polished surface of the cap. To apply
grease:

Follow these instructions carefully. Toomuch grease exposes the sample to an
unwanted coating and is likely to cause slippage andmisalignment of themating
surfaces. Too little grease results in an imperfect seal.

a. Use a fingertip to apply a light coating of grease to the lip of the bulb.

b. Smooth the grease evenly around the lip of the bulb.

c. Remove all excess grease from both the inside and outside of the bulb.
2. Hold the penetrometer upright. Place a cap over the greased bulb and turn the cap one half

turn to seat.

Seal the Penetrometer
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5 Perform an Analysis

3. Place the penetrometer tool over the nut.

4. Place the wrench peg into a hole in the penetrometer nut. Use the penetrometer tool to
stabilize the cap while tightening the nut counter-clockwise.
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5. Weigh the penetrometer before installing it in the low pressure port. SeeWeigh the
Assembled Penetrometer with Sample below.

WEIGH THE ASSEMBLED PENETROMETER WITH SAMPLE

To avoid transferring skin oils, it is recommended to wear latex gloveswhen handling
penetrometers. Skin oilsmay affect results.

1. Weigh the assembled penetrometer with sample using an analytical balance. Do not include
the spacer when weighing.

2. Record themass on theSample DataWorksheet asSample + Penetrometermass.
3. SubtractSamplemass fromSample + Penetrometer mass. Record on theSample Data

Worksheet asPenetrometer mass.

Themass of the penetrometer must be determined by thismethod in order to account
for themass of the sealing grease, which varies with each application.

Weigh the Assembled Penetrometer with Sample
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5 Perform an Analysis

INSTALL THE PENETROMETER

l Install a Penetrometer in a High Pressure Chamber on page 10-1
l Install a Penetrometer in a Low Pressure Port on page 10-3
l Remove a Penetrometer from a High Pressure Chamber on page 10-5
l Remove a Penetrometer from a Low Pressure Port on page 10-6
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PERFORM A LOW PRESSURE ANALYSIS
Unit [n] > Low Pressure Analysis

l Select the sample files for analysis for each port
l Edit the penetrometer properties
l Edit analysis conditions
l Monitor analysis as data are collected

Prior to starting an analysis, verify that the tank pressure for the gas regulator is at least
200 psig. Pressures less than 200 psigmay cause inaccurate data or termination of ana-
lysis.

1. SelectOperation from theView drop down to enter or edit analysis information.
2. Install a Penetrometer in a Low Pressure Port. Install a steel rod with cap detector in any low

pressure port that does not contain a penetrometer. See Install a Penetrometer in a Low
Pressure Port on page 10-3.

3. For a selected port, clickBrowse and select a sample file or clickNew to create a sample file.
If needed, change thePenetrometer mass and/or Samplemass field for the samplematerial
being analyzed.

4. ClickStart to start the analysis. A window displays data as they are collected. A short delay is
encountered before the port status at the bottom of the window changes from the Idle state.
SeeMonitor a Low Pressure Analysis on page 5 - 15.

Perform a Low Pressure Analysis
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5 Perform an Analysis

l When theStart button is clicked, if any low pressure station does not show a cap
detector reading that indicates the station has a penetrometer or rod and its cap
detector in place, a warningmessage will be displayed and the analysis will not start.

l When the next scheduled pressure is above atmospheric pressure and a cap
detector and rod or pen is not in place, the samewarning will be displayed and the
analysis will be suspended until the operator has corrected the problem and
resumed.

l If a cap detector is removed when the pressure is above atmospheric pressure, the
low pressure systemwill be vented to atmosphere and the analysis canceled, with an
explanatory error message.

5. When the analysis is complete, remove the penetrometer and store (or dispose of) the sample
material as applicable. SeeRemove a Penetrometer from a Low Pressure Port on
page 10-6.

Field or Button Description

Penetrometer mass This information is pulled from the selected sample file. Modify the pen-
etrometer mass in this field as needed.

Sample mass This information is pulled from the selected sample file. Modify the
samplemass in this field as needed.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Low Pressure Analysis Fields and Buttons Table
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EVACUATE LOW PRESSURE

See Low Pressure inAnalysis Conditions on page 4 - 2

Unit [n] > Evacuate Low Pressure
Select the type of sample when performing a low pressure evacuation. This window is also available
using theEvacuation button on theAnalysis Conditions tab.

Select if the sample is a Formed solid, Powder, orOther. IfOther is selected, the remaining fields are
enabled.

Field or Button Description

Initially evacuate at Enter the initial maximumevacuation rate.

Switch to medium at Enter themethod and pressure the systemmust reach beforemedium
evacuation begins.

l Use pressure transducer
l User vacuum gauge
l Skipmedium evacuation .

Switch to fast at Enter the pressure the systemmust reach before fast evacuation

Evacuate Low Pressure Fields and Buttons Table

Evacuate Low Pressure
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5 Perform an Analysis

Field or Button Description
begins.

Evacuation target Enter the evacuation pressure.

Continue evacuating
for

Enter the evacuation duration.

Evacuate Low Pressure Fields and Buttons Table (continued)

GENERATE LOW PRESSURE

Unit [n] > Generate Low Pressure
Pressure can be generated in the low pressure systemwhen a low pressure analysis is not already
in progress.

Threaded penetrometer closures are required for pressures above 30 psia or
0.2068 MPa.
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MONITOR A LOW PRESSURE ANALYSIS

This live graph displays data as they are collected. It also shows intrusion as a function of pressure.
The status section below the graph displays the following for each port:

l Sample file name
l Intrusion volume
l Percent of the penetrometer stem that is filled with mercury

Whenmonitoring a low pressure analysis, the analyzer schematic can be displayed to
show the state of the low pressure system components. SeeShow Instrument
Schematic on page 2 - 16.

Field or Button Description

Pressure Displays the current pressure in the low pressure system. The reading
shown is from either the vacuum gauge or the 50 psia transducer,
depending upon which is currently in range.

Resume Restarts the suspended analysis.

Skip Moves to the next step. Select the ports to skip.

Status Displays current low pressure status.

Suspend Suspends an analysis in progress.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Low Pressure Analysis Fields and Buttons Table
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AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017 5 - 15



5 Perform an Analysis

PERFORM A HIGH PRESSURE ANALYSIS
The analyzer is designed to perform two high pressure analyses simultaneously. To run only one
analysis, the other chambersmust be closed tightly and have sufficient high pressure fluid to be
drawn into the vent valve.

Unit [n] > High Pressure Analysis
Low and high pressure analyses can be performed simultaneously.

l Select the sample files for analysis for each port
l Edit the penetrometer properties
l Edit analysis conditions
l Monitor analysis as data are collected

Each sample’s high pressure analysis should be performed on the same analyzer as the
low pressure analysis. The analyzer checks to see that the same analyzer is used before
it begins the high pressure analysis; if it is not, the analyzer displays a warningmessage.
The analysis can be continued or canceled.

1. Select the sample file with a status of Low Pressure Complete orHigh Pressure Complete.

If a selected sample file to be analyzed on a 9505 analyzer contains pressures exceeding
33,000 psia, the followingmessage displays:

l Click Yes to proceed with the analysis; only pressures less than
33,000 psia will be used.

l Click No to cancel the analysis.
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2. Install a Penetrometer in a High Pressure Port. See Install a Penetrometer in a High Pres-
sure Chamber on page 10-1.

3. ClickStart to start the analysis immediately. A live graph of the analysis displays as data are
being collected. SeeMonitor a High Pressure Analysis on page 5 - 19.

4. Remove the penetrometer after the analysis. SeeRemove a Penetrometer from a High
Pressure Chamber on page 10-5.

If it was not requested that the transducer offset be determined (Options >
Atmospheric Pressure), and if the current high pressure reading differs significantly
from the atmospheric pressure, a prompt displays requesting verification that the system
is at atmosphere.

For maintenance purposes, it is possible to perform a high pressure analysis with no
penetrometer. Open theHigh Pressure Analysiswindow and enter the name of a file
with aNoAnalysis status. Continue the analysis after a warningmessage displays.

Field or Button Description

Analysis type Regular.Performs a differential analysis with the blank penetrometer
in port 1.

Differential, blank in port 1. Performs a differential analysis with the
blank penetrometer in port 1.

Differential, blank in port 2. Performs a differential analysis with the
blank penetrometer in port 2.

SeeHigh Pressure Differential Analysis on page 5 - 20
Assembly mass Sample + penetrometer + mercurymass.

Atmospheric pressure Enter the atmospheric pressure if it differs from the default entry. The
default entry is pulled from the information entered inOptions
> Atmospheric Pressure.

Determine transducer
offset

Select to allow the system to determine the transducer offset. The
default entry is pulled from the information entered inOptions
> Atmospheric Pressure.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

High Pressure Analysis Fields and Buttons Table

Perform aHigh Pressure Analysis
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5 Perform an Analysis

GENERATE HIGH PRESSURE

Unit [n] > Generate High Pressure
Pressure can be generated in the high pressure systemwhen a high pressure analysis is not already
in progress.
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MONITOR A HIGH PRESSURE ANALYSIS

This live graph displays data as they are collected. It also shows an intrusion as a function of
pressure. The status section below the graph displays the following for each port:

l Sample file name
l Intrusion volume
l Percent of the penetrometer stem that is filled with mercury

Whenmonitoring a high pressure analysis, the analyzer schematic can be displayed to
show the state of the high pressure system components.

Field or Button Description

Pressure Displays the current pressure in the high pressure system.

Skip Moves to the next step. Select the ports to skip.

Resume Restarts the suspended analysis.

Status Displays the high pressure's current status.

Suspend Suspends an analysis in progress.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

High Pressure Analysis Fields and Buttons Table

Monitor a High Pressure Analysis
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5 Perform an Analysis

HIGH PRESSURE DIFFERENTIAL ANALYSIS

If using a blank correction file as the correctionmethod, the correction file must exist before the
sample data file can be completed (since a blank correction file must be selected when the sample
file is created).

If a blank analysis has not been performed in advance, run a differential analysis of the sample and
the corresponding blank simultaneously. The application associates the sample file with the blank
correction file after the analysis is completed.

An advantage of using differential analysis is that both the sample and blank penetrometers are
subjected to nearly identical conditions (time, temperature, and pressure). Properly used, the
differential analysis option provides themost accurate low porosity sample data possible.

1. Create a sample file. Also create a sample file for the blank penetrometer usingNonefor the
correctionmethod. SeeSample Files on page 3 - 1.

2. Run the low pressure analysis on both files. SeePerform a Low Pressure Analysis on
page 5 - 11.

3. To start the high pressure analysis, select either theDifferential, Blank in port 1 orDifferential,
Blank in port 2. Perform a high pressure analysis. SeePerform a High Pressure Analysis
on page 5 - 16.
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REFERENCE MATERIAL ANALYSIS

HIGH PRESSURE REFERENCE MATERIAL ANALYSIS

Unit [n] > High Pressure Reference Analysis
A referencematerial analysis is used to verify the analyzer is operating properly and producing
optimum results. Thesemethods provide specifications for critical report quantities and reporting of
whether quantities are in or out of specification.

When running a referencematerial analysis, use the appropriate referencematerial provided in the
accessories kit to perform this analysis. The results shouldmatch those shown on the label of the
referencematerial bottle, within the tolerance level.

Field or Button Description

Assembly mass This information is pulled from the selected sample file.
Sample + penetrometer + mercurymass.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

High Pressure Reference Material Analysis Fields and Buttons Table

ReferenceMaterial Analysis
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5 Perform an Analysis

LOW PRESSURE REFERENCE MATERIAL ANALYSIS

Unit [n] > Low Pressure Reference Analysis
A referencematerial analysis is used to verify the analyzer is operating properly and producing
optimum results. Thesemethods provide specifications for critical report quantities and reporting of
whether quantities are in or out of specification.

When running a referencematerial analysis, use the appropriate referencematerial provided in the
accessories kit to perform this analysis. The results shouldmatch those shown on the label of the
referencematerial bottle, within the tolerance level.

Field or Button Description

Penetrometer Penetrometer description from the selected sample file.

Penetrometer mass Penetrometer mass from the selected sample file.

Sample mass Samplemass from the selected sample file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Low Pressure Material Reference Material Analysis Fields and Buttons Table
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LEAPFROGGING - SUGGESTED SEQUENCE FOR MAXIMUM THROUGHPUT
Leapfrogging is a procedure for running low and high pressure systems simultaneously to maximize
throughput. This process describes leapfrogging a group of eight samples. It is possible to leapfrog
groups of samples continuously.

If samples require longer vacuum preparation or heated evacuation, increase the
throughput by preparing samples in a vacuum oven.

1. Prepare and weigh eight samples. Load eight penetrometers with samples then weigh them.
Complete theSample Data Worksheet on page F - 6 and install samples 1 through 4 in
the low pressure ports.

2. Create sample files for at least the first four samples.
3. Go toUnit [n] > Low pressure analysis to start the low pressure analysis.
4. When the run is complete, remove samples 1 through 4 from the low pressure ports and

weigh them. Install samples 5 through 8 in the low pressure ports.
5. Start another low pressure run.
6. Place samples 1 and 2 in the high pressure chambers.
7. Go toUnit [n] > High pressure analysis to start the high pressure analysis.

While waiting for analysis to complete, samples files can be created and other samples
can be prepared for analysis.

8. When the high pressure run is complete, remove samples 1 and 2 from the high pressure
chambers and replace with samples 3 and 4.

9. Start another high pressure run.
10. Automatic reports specified in each sample file will print when that sample’s high pressure run

ends.
11. When the second low pressure run and the second high pressure run end, remove samples 3

and 4 from the high pressure chambers. Remove samples 5 through 8 from the low pressure
ports and weigh them.

12. Install samples 5 and 6 in the high pressure chambers. Start another high pressure run.
13. When the third high pressure run is finished, install samples 7 and 8 in the high pressure cham-

ber and start another high pressure run.

Leapfrogging - Suggested Sequence for Maximum
Throughput
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6 ABOUT REPORTS
Reports > Open Report > [.REP file]
Opens a saved report.

Reports > Close Reports
Closed all open reports. This option is unavailable if reports are being generated.

Reports > Start Report
Generates a report an a sample analysis.

Reports can be generated for data collected on a sample that has completed analysis, collected on a
sample currently being analyzed, or manually entered.

SPC REPORT
Reports > SPC Report Options
Use to generate reports with variousSPC (Statistical ProcessControl) options. All selected
variablesmust be computed for each sample file used in an SPC report; therefore, it is more efficient
to select only the necessary variables.

6 About Reports
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6 About Reports

REGRESSION REPORT
Reports > Regression Report
Use to generate a Statistical ProcessControl (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is
also reported.

Field or Button Description

Autoscale [check box] When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box] Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box] Use to label the points on the plot to correspond with the values in the
sample files.

Recalculate archived
SPC results [check box]

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make
some archived sample files unreadable by the original
application. If an earlier application version will not be
reused, this warningmessage can be safely disregarded.

When this option is selected, thismessage will display:

Regression Report Fields and Buttons Table
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Field or Button Description
Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

IfDo not show me thismessage again is selected, themes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

Samples [button] Select additional sample files to add to the report.

Save as Default [button] Click to save selected report options as default report settings.

Show graphic
[check box]

Use to show a graphic on the report header.

Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

X- and Y-Axis Variable
[drop-down box]

Use to designate the x- and y-axes variables. The variables in the
drop-down lists are those selected in theReports > SPC Report
Optionswindow. Use these options to plot the regression of up to
three y-axis variables against the x-axis variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Regression Report Fields and Buttons Table (continued)

Regression Report
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6 About Reports

CONTROL CHART REPORT
Reports > Control Chart
Generates a Statistical ProcessControl (SPC) control chart report which plots the changes in a
statistic.

Field or Button Description

Graph [n] [button] Defines the y-axis of each graph.

Statistic. Displays the SPC variables selected on theReports >
SPC Report Optionswindow. The selected variable will be plotted
for each selected sample. This selection also becomes the y-axis label.

Autoscale.Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To fields.

Center Line.Displays placement options for the center line in the
graph. SelectEntered to specify placement of the line orMean to place
the center line at the calculatedmean value for the selected samples.

Limit Lines group box. Displays limiting lines options. Lines can be
placed at somemultiple of the standard deviation or at specified
positions (Entered). WhenEntered is selected, enter theHigh limit and
Low limit fields with appropriate values.

Control Chart Fields and Buttons Table
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Field or Button Description

Recalculate archived
SPC results [check box]

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make
some archived sample files unreadable by the original
application. If an earlier application version will not be
reused, this warningmessage can be safely disregarded.

When this option is selected, thismessage will display:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

IfDo not show me thismessage again is selected, themes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Show graphic
[check box]

Use to show a graphic on the report header.

Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

Control Chart Fields and Buttons Table (continued)

Control Chart Report

AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017 6 - 5



6 About Reports

Field or Button Description

X Axis Order by
[group box]

Select the order in which x-axis statistics are placed. Sort by: 

Time. Time the files were analyzed.

File name. Alphanumeric order.

Date. Date the files were analyzed.

Minutes.Minutes elapsed from the first file placed on the list, which is
the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Control Chart Fields and Buttons Table (continued)
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PSD HISTORY REPORT
Reports > PSD History
ThePSD History Report generates a sequence of full pore size distribution graphs.

Field or Button Description

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Save as Default [button] Click to save selected report options as default report settings.

Show [selection] Select one of the following options:

First Intrusion.Select to show the first intrusion segment.

First Extrusion.Select to show the first extrusion segment.
Show bitmap
[check box]

Use to show a graphic on the report header.

Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

PSD History Report Fields and Buttons Table

PSD History Report
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6 About Reports

Field or Button Description

X-axis Order By
[selection]

Select one of the following:

Time. Time the files were analyzed.

File name.Alphanumeric order.
X Axis variable
[selection]

Select one of the following to display on the graph:

Pressure.

Pore size.
Y Axis variable
[selection]

Select one of the following to display on the graph:

Diff. volume.

Diff. % volume.

Diff. area.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

PSD History Report Fields and Buttons Table (continued)
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INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1. When opening a sample file that contains analysis data, a window with the following inform-
ation will display:

l an intrusion linear plot and log plot of the data collected during analysis
l a summary of the analysis giving a single total intrusion volume and other important quant-
ities

2. Modify the intrusion graph to show all or first intrusion and/or extrusion segments by selecting
an option from the Intrusion or Extrusion drop-down lists.

3. Add an overlay to the intrusion graph by selecting an option from theOverlay drop-down list.
4. To view the reports selected for generation during or after analysis, clickPreview.
5. From the drop-down list at the bottom of the window:

l change the option presentation of the sample information window to either Basic or
Advanced to modify certain file parameters, or

l select another plot from the list and edit the data contained in the plot.

6. When ranges are edited, the changes are reflected immediately in the plots and the summary
data displayed in the window. Some editing options are:

l Drag the blue bars to increase or decrease the range of data included in the plot.
l Right click to display a popupmenu to include reports; enable or select overlays; edit
curves, axes, legends, titles; and copy and paste the data in a graph or in tabular format

7. ClickSave.

Interactive Reports
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6 About Reports

REPORT FEATURES AND SHORTCUTS
Reports can be customized andmanipulated using the toolbar, shortcut menus, the zoom feature, or
axis cross-hairs.

l After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
l The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.
l All reports contain a header displaying file statistics.

If configured, the report header can also contain a graphic and/or a title.

l Tabular and graphical reports contain sample and analyzer statistics such as analysis date / time,
analysis conditions, etc.

l The headers contain notes of sample file changes occurring after analysis.
l Summary report headers contain the same information as tabular and graphical reports with the
exception of notes.
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REPORT HEADER SHORTCUTS

Display header shortcuts by right clicking in the report header.

If configured, the report header can also contain a graphic and a title.

l Tabular and graphical reports contain sample and analyzer statistics— such as analysis date,
analysis time, analysis conditions, etc.

l The headers contain notes of sample file changes occurring after analysis.
l Summary report headers contain the same information in tabular and graphical reports with the
exception of notes.

Field or Button Description

Copy header as text Use to copy the report header as text. Text is copied to the clipboard
and then can be pasted into other documents.

Edit Use to edit the report title and/or graphic in the report header.

Report header Shortcut Field and Button Table

Report Header Shortcuts
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6 About Reports

REPORT TOOLBAR

TheReportwindow has a toolbar on the right portion of the window and selectable tabs at the top of
the report header. To view a specific report, either select the tab or the report in theReports list box,
then clickShow.

Field or Button Description

Default Style [button] Specify default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in theReports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in theReports list box.

Print [button] Displays thePrintwindow for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hidden
using theHide button.

Show [button] Displays the selected or hidden report in theReports list box.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Report Toolbar Fields and Buttons Table

6 - 12 AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017



TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right clicking in the body of the tabular report. Column shortcuts
require right clicking on the column to bemodified.

Field or Button Description

Align column Select to change the column alignment to either left, right, or centered.

Copy table as text Use to copy the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Use to edit the report title and/or title font attributes. ClickFont to
modify font attributes.

Move column Right click the column to bemoved. SelectMove column on the short-
cut menu and select Left orRight for themove.

Rename column Right click the column to be renamed. SelectRename column on the
shortcut menu and enter the new column name.

Resize column Right click the column to be resized. SelectResize column on the short-
cut menu and enter the new columnwidth in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right click in the report data. Select Table data font on the shortcut
menu.

Table header font Right click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Tabular Reports Shortcut Options and Descriptions Table

Tabular Report Features and Shortcuts
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6 About Reports

GRAPH FEATURES AND SHORTCUTS

Display graph report shortcuts by right clicking in the body of the graph area.

Field or Button Description

Autoscale all axes Returns the report to full view after using the zoom feature.

Edit axis Use to edit the selected axis properties.

Autoscale minimum / maximum. Tomanually specifyminimum
/ maximumautoscale, deselect the option and enter the new
amount in the text box.

Grid lines.Use to change how to displaymajor / minor grid lines.

Invert scale. Use to invert the scale.

Graph Shortcuts Options and Description Table
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Field or Button Description
Linear / Logarithmic.Select the option to scale the graph as
linear or logarithmic.

Scale font. Use tomodify the font for the scale label. Deselect
Use default font to enable font options.

Title.Use to edit the selected axis label.

Title font.Use tomodify the font for the selected axis label.
Deselect Use default font . Select new font attributes for report
data. EnableUse default font to reset default fonts.

Graph Shortcuts Options and Description Table (continued)

Graph Features and Shortcuts
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6 About Reports

Field or Button Description

Edit curve Use to edit selected curve properties.

Color.Click to change the curve color.

l Curve [group box].Use to change the interpolation, point style
and pen style for the selected curve. These options are disabled
ifUse default fill style is selected in theHistogram group box.

l Histogram [group box]. Enabled only ifHistogram is selected
in theStyle drop-down list. Use to specify the type of fill, fill color
and label position for the selected curve.

Label.Select where the graph point labels will display (left, right,
center, etc.) on the SPC report.

Style.Use to select another style for the collected data curve.

Title. Use to change the title of the selected curve.

Use default thickness.Uses the default curve thickness.
Deselect to enter a new thickness number in the Thickness text
box.

Edit imported data Usedwith pore distribution data reports only. Use to select
ASCII text files for import onto the active graph.

Graph Shortcuts Options and Description Table (continued)
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Field or Button Description

Edit legend Use to change the legend location and font.

Edit title Use to change the graph title and font.

Enable Overlays If overlays have been selected, this option displays (or hides) the
overlays.

Include report When selected, places a checkmark to the left of the report in the
Select Reports list box on theReport Options tab.

Reset axis limits to initial
setting

Removes the cross-hair and returns the graph back to the initial
setting.

Select overlays... Displays the option to select files to overlay onto the active graph.
To view the overlays, clickEnable Overlays on the shortcut menu.

Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Graph Shortcuts Options and Description Table (continued)

Graph Features and Shortcuts
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6 About Reports

Axis Cross-Hair

Left click on the graph to view the cross-hair coordinates.
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Graph Grid Lines

Options > Graph Grid Lines

Use to select how grid lines appear on reports. Thismenu option is not available if usingRestricted
option presentation.

Field or Button Description

Grid Line Styles
[selection]

Select if themajor and/or minor grid lines should appear as solid or dot-
ted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the logarithmic
and linear scales. Deselect this option to remove the grid lines.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Graph Grid Lines Fields and Buttons Table

Zoom Feature

Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A boxwill display in the area to be enlarged. To return to normal view,
right click in the graph and selectAutoscale.

Graph Features and Shortcuts
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6 About Reports

GRAPH AND SAMPLE OVERLAYS

Use the graph overlay functions to comparemultiple graph options. Graphical lines are differentiated
by the use of varying colored symbols outlined on a legend. Overlaysmay be generated in two ways:

l Multiple Graph Overlays.Overlay two different types of graphs from one sample.
l Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot.

This feature is available only when usingAdvanced option presentation. Go toOptions
> Option Presentation > Advanced.

GENERATE PORE SIZE DISTRIBUTION GRAPH OVERLAYS

The following reports in themercury porosimetry application can produce graphical results for a
samplematerial's pore size distribution:

Physical Adsorption Mercury Porosimetry

l BJH Adsorption / Desorption
l Dollimore-Heal Adsorption / Desorption
l Horvath-Kawazoe
l DFT Pore Size

l Cumulative
l Differential
l Incremental Intrusion graphs

Twomethods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

l Import ASCII text data.Data can be imported from an ASCII text file into the interactive graph.
The ASCII text file must follow certain rules.

l Copy / paste.Data can be copied and pasted from one sample file (source) and pasting into
another sample file (target).

Pore size distribution report overlaysmenu selections are:

l Copy data.Used to copy data sets.
l Paste data.Used to paste data sets.
l Edit Imported Data.Used to edit data sets.
l Display Imported Data.Used to hide or show the imported data.
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IMPORT ASCII TEXT DATA

ASCII text file format rules

l The header must consist of one line to include title, two unit specifications, and distribution type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, ml/g
o Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

l The datamust be in two columns and should be separated by a comma or white-space.
l The data linesmust be ordered so that pore dimensions aremonotonically increasing or decreas-
ing.

silica alumina bjh (A, cm3/g, cumulative)

456.657
444.847
429.168
425.419
419.629
360.634
340.859
326.601

0.0133559
0.0546427
0.0869924
0.119721
0.132681
0.156611
0.197672
0.233092

Sample ASCII Text File

Window appearance will vary depending on the selected report. This function can be performed on
samples files with aCompleted status or during an analysis.

1. Create the ASCII text file using the proper format as indicated above.
2. In the analyzer application, go to File > Open. Select a sample file to overlay graphs on to.

ClickOpen (or double-click the file name).
3. Right click in the graph area and selectEdit imported data.
4. In theSelect Imported Overlayswindow, if the ASCII text file does not display, click Import to

locate the file. Select the ASCII text file in theSelect Imported Overlayswindow, then click
OK. If an error message will display instead, verify that the .TXT file format is in the correct
format.

5. To include the overlay data in a printed report, seePrint Pore Size Distribution Overlay
Data in Reports on the next page.

Generate Pore Size Distribution GraphOverlays
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6 About Reports

OVERLAY PORE SIZE DISTRIBUTION DATA USING COPY/PASTE
1. Open a source sample file and a target sample file; both should have aComplete status. The

report will open to the interactive reports window.
2. In the source sample file, right click on the graph and selectShow Curve. Deselect any dif-

ferential curve data to hide them in the graph.
3. Right click in the graph area again and selectCopyData.
4. Change to the target sample file, right click the graph, and selectPaste data. The graph now

displays overlayed data from the source sample file.

Typically, one new graph will appear showing both the cumulative and differential curves. To
show or hide individual curves, right click the graph and select (or deselect)Display imported
data.

5. Ensure that all parameter fields are set appropriately, then click thePaste button.
6. To include the overlay data in a printed report, seePrint Pore Size Distribution Overlay

Data in Reports below.

Print Pore Size Distribution Overlay Data in Reports

1. Open the sample file containing the overlay data and selectAdvanced from the drop-down list
at the bottom of the window.

2. Click theReport Options tab.
3. In theSelected Reports list box, select the cumulative, differential, or incremental intrusion

graph to show the imported distribution data, then clickEdit (or double-click the selected
report).

4. In theOverlay drop-down box, select Imported.
5. ClickOK to close the window.
6. ClickPreview on theReport Options tab. ClickPrint in the reports toolbar section to display

print options.

IMPORT ASCII PORE DISTRIBUTION DATA

IMPORT AN ASCII TEXT FILE USING GRAPH SHORTCUTS

1. Create an ASCII text file. SeeManually Enter Data on page 3 - 8.
2. Open a report with aComplete status.
3. Select a pore-size distribution report from the drop-down list at the bottom of the window.
4. Right click on the graph and selectEdit imported data on the shortcut menu.

If the ASCII text file does not display on theSelected Imported Overlayswindow, click Import.
Locate and select the file, then clickOpen. Header information from the ASCII text file will
appear in theSelect Imported Overlayswindow. Select the entry, then clickOK. If an error
message appears, verify that the .TXT file format is correct.
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5. To hide or show imported data, right click in the graph area and use theDisplay imported data
option on the shortcut menu.

COPY / PASTE AN ASCII TEXT FILE USING GRAPH SHORTCUTS

1. Create an ASCII text file. SeeManually Enter Data on page 3 - 8.
2. Copy the ASCII text data to the clipboard.
3. Open a report with aComplete status.
4. Select a pore-size distribution report from the drop-down list at the bottom of the window.
5. Right click on the graph and selectPaste data on the shortcut menu.
6. To hide or show imported data, right click in the graph area and use theDisplay imported data

option on the shortcut menu.

COPY / PASTE GRAPH DATA FROM ANOTHER GRAPH

1. Open a source pore distribution data report with aComplete status.
2. Right click on the graph and selectCopyData on the shortcut menu.
3. Open the target pore distribution data report.
4. Right click on the graph and selectPaste Data on the shortcut menu.
5. To hide or show imported data, right click in the graph area and use theDisplay imported data

option on the shortcut menu.

OVERLAY MULTIPLE MERCURY POROSIMETRY GRAPH OPTIONS

1. Go to File > Open.
2. Select the .SMP file, then clickOpen.
3. SelectAdvanced from the drop-down list at the bottom of the window.
4. Click theReport Options tab.
5. In theReports list box, highlight a plot report, then clickEdit.

OverlayMultiple Mercury PorosimetryGraphOptions
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6 About Reports

6. On thePlot Optionswindow, selectOptions to include in the overlay. If the x- and/or y-axes are
to be autoscaled, selectAutoscale; otherwise, enter the From and To points for the axes.

7. In theY-Axis group box, selectVariable and/orOverlay options.
8. ClickOK to return to theReport Options tab.
9. ClickSave, Save As, or Preview.

OVERLAY MULTIPLE SAMPLE FILES

This feature is applicable to overlaying samples from samples files with an LP Complete,HP
Complete or Entered status.

1. Go to File > Open.
2. Select the .SMP file, then clickOpen. SelectAdvanced from the drop-down list at the bottom

of the window to display theReport Options tab.
3. Click theReport Options tab.
4. In theReports list box, highlight a plot report, then clickOverlays.

5. On thePlot Overlay Sample Selectionwindow, move files from theAvailable Files box to the
Selected Files box.

6. ClickSave, Save As, or Preview.
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REPORT EXAMPLES

SILICA ALUMINA REFERENCE MATERIAL REPORT

Report Examples
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6 About Reports

GARNET TABULAR REPORT
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CONTROLLED PORE GLASS PLOT

Report Examples
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7 SELECTED REPORTS

To edit reports, open theSample Information file. Select theReport Options tab, then
highlight the report name in theSelected Reports list box. ClickEdit.

GRAPH REPORT OPTIONS

l Cumulative Area vs Size Plot Options
l Cumulative Volume vs Pressure Plot Options
l Cumulative Volume vs Size Plot Options
l Difference fromReference% Volume Plot Options
l Differential Intrusion Plot Options
l Differential Volume vs Size Plot Options
l Incremental Volume vs Pressure Plot Options
l Incremental Volume vs Size Plot Options
l Log Differential Intrusion Plot Options
l Out of Specification% Volume Plot Options

7 Selected Reports
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7 Selected Reports

Field or Button Description

Autoscale [check box] When enabled on the report parameters windows, allows the x- and
y- axes to be scaled automatically.Autoscalemeans that the x- and
y- rangeswill be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Options [check box] Plot Points.Select to plot the points on the graph.

Plot Curve. Interpolated from data points.

Show As Histogram.When selected,Plot Points andPlot Curve
options are disabled.

Overlays [button] Select sample files that contain data to be overlayed onto the selected
plot.

Reference [button] Select a sample file to compare analysis results of the current sample.

Specification [button] Specify sample files to use for the boundaries of the coarse and fine
specifications.

X-Axis [group box] Select options for the x-axis.

Variable.

Scale.
Y-Axis [group box] Select options for the y-axis.

Variable. Select the y-axis variable from the drop-down list.

Overlay. [Optional]. Select an option to overlay.

Intrusion / Extrusion.Select the data points to plot.

l None.No intrusion (or extrusion) data points
l First.Points from the first intrusion (or extrusion) cycle
l All. Include all intrusion (or extrusion) data points

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Graph Report Options Fields and Buttons Table
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CAVITY TO THROAT SIZE RATIO REPORT OPTIONS

Select to show the cavity to throat size ratio plot ratio table.

Field or Button Description

Cavity to throat size
ratio plot [check box]

Displays the ratio plot.

Cavity to throat size
ratio table [check box]

Displays the ratio table

Pressures [button] Enter theminimumandmaximum calculation pressure range.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Cavity to Throat Size Ratio Fields and Buttons Table

Cavity to Throat Size Ratio Report Options
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7 Selected Reports

FRACTAL DIMENSION REPORT OPTIONS

The fractal dimensions can be shown as a graph, table, or both. The graph and table reports contain
the fractal dimension and the RMS error to give an indication of the quality of the fit.

Field or Button Description

Backbone region
[text box]

Enter the pressure at which the calculations are to be performed.

Percolation region
[text box]

Enter the pressure at which the calculations are to be performed.

Pressures [button] Select to enter minimumandmaximumpressures.

Select Reports
[check box]

Show Log(V) vs Log (P-Pt) graph.Select to generate an additional
graph to help select linear range for calculations.

Backbone region.

Percolation region.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Fractal Dimension Report Fields and Buttons Table
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MATERIAL COMPRESSIBILITY REPORT OPTIONS

The compressibility calculations can be shown as a graph, table, or both. The graph and table
reports contain the linear and quadratic c compressibility values and the RMS error to give an
indication of the quality of the fit. The linear and quadratic compressibility coefficients from this report
can be copied into aMaterial Properties parameter file for use in future sample analyseswith the
samematerial.'

Field or Button Description

Pressures [button] Enter the Calculation pressure range.

Range [text box] P1. Enter the beginning pressure.

P2. Enter the ending pressure.
Select Reports
[group box]

Material compressibility correction plot.Displays the results in
graph format. The graph plots pressure on a log scale on the x-axis
and the volume compressed readings as points on the y-axis, with the
theoretical curve based on the calculated values overlaid.

Tabular report. Displays the results in table format. The table
displays pressure, volume compressed, predicted volume
compressed, and error.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Material Compressibility Fields and Buttons Table

Material Compressibility Report Options
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7 Selected Reports

SAMPLE LOG REPORT
This report provides information on:

l Manual control operations performed during analysis
l Information entered usingAdd Log Entry on the sample file editor
l Warnings and/or errors which occurred during analysis

SUMMARY REPORT
TheSummaryReport provides a condensed listing of selected data results.

Field or Button Description

Intrusion Summary
[group box]

Select the intrusion options to include in the report. If Bulk Density is
selected, enter the pressure for themeasurement. If the entered pres-
sure is below the filling pressure, the filling pressure will be used in the
report.

Physical Properties
Summary [button]

Select the physical properties to display on the report.

Summary Report Fields and Buttons Table
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Field or Button Description

Pore Structure
Summary [button]

Select the pore structure to be included in the report.

Show Graph [check box] Displays the report in graph format. ClickOptions to select how the
graph should display.

SeeReport Options on page 4 - 10 for a description of fields and
buttons on this window.

Summary Report Fields and Buttons Table (continued)

SummaryReport
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7 Selected Reports

Field or Button Description

Show Peak Table
[check box]

Displays the peak table in the report. ClickOptions to select how the
graph should display.

Auto.Select to have the system automatically identify peaks based on
the enteredminimum valley depth to separation peaks. Enter the
minimum settings.

Manual. Select to manually enter theminimumandmaximum
diameter or volume for each peak in the table.

Show Percent Intrusion
[table]

ClickOptions to enter the percentile intrusion for the report. Use the
drop-down fields to specify the data to appear in the specified columns
for report generation.

Summary Report Fields and Buttons Table (continued)
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Field or Button Description

Show Pore Size Table
[check box]

Select to show pore size in the report. ClickOptions to select points to
display. Use the drop-down fields to specify the data to appear in the
specified columns for report generation.

Show Pressure Table
[check box]

Select to display pressure points in the report. ClickOptions to select
points to display. Use the drop-down fields to specify the data to
appear in the specified columns for report generation.

Total intrusion volume
[check box]

Enables thePass/Fail button.

Upper / Lower.Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right ofUpper / Lower, enter operator instructions to be
displayed if a failure is encountered.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Summary Report Fields and Buttons Table (continued)

SummaryReport
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7 Selected Reports

TABULAR REPORT OPTIONS

Tabular reports display the numerical values for the data points. Up to six columns of data can be
selected to display on the report.

In the Tabular Data Definition group box, indicate select eitherCollected data or Tabular data set for
this report.

Field or Button Description

Column [n]
[drop-down box]

Use the drop-down fields to specify the data to appear in the specified
columns for report generation.

Tabular Data Definition
[group box]

Collected data.Select to use data points collected during analysis.
Data are collected at equilibration points on or about the pressure
points specified in the pressure table used for each analysis.

Tabular data set. Select to have a table of specific pressure points or
pore sizes included in tabular reports. Allows for the comparison of
data from various runs, because it interpolates values from each
sample run at the points specified in the table. When this option is
selected, the Table button is enabled.

Tabular Report Options Fields and Buttons Table
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Field or Button Description

l Data Type. Select either Pressure Pointsor Pore sizes as the data
type.

l Click Insert to insert a data point immediately before the selected
point. To complete the table quickly, enter the highest value in the
set, then click Insert to enter points below that value.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Tabular Report Options Fields and Buttons Table (continued)

Tabular Report Options
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8 DIAGNOSTICS
Unit [n] > Diagnostics
Use to display diagnostic readings, start and schedule diagnostic tests, and open saved diagnostic
reports. Each test generates a file to the default directory name and path of ...\...\Service\userdiag
unless another directory namewas specified. These reports can be sent to aMicromeritics service
representative for examination.

START DIAGNOSTIC TEST
Unit [n] > Diagnostics > Start Diagnostic Test
Provides amethod to start a diagnostic test immediately. Upon completion of the diagnostic test, the
file is saved as a .REP file which can be retrieved by going toReports > Open Report and
selecting the report file.

Field or Button Description

Comments [text box] Displays comments from the selected diagnostic test.

Estimated time (min.) Approximate time for test completion.

File [group box] Shows a status bar of steps complete once the test begins.

Next [button] Starts the next test.

Operator [text box] Enter information to identify the person running the service test.

Repeat [button] Repeats the selected diagnostic test.

Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Start Diagnostic Test Fields and Buttons Table

8 Diagnostics
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8 Diagnostics

Field or Button Description

Test [drop-down box] Select the diagnostic test to be performed.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Start Diagnostic Test Fields and Buttons Table (continued)

SCHEDULE DIAGNOSTIC TESTS
Unit [n] > Diagnostics > Schedule Diagnostic Tests
Allows the specification of one-time or periodic running of a sequence of diagnostic tests. A separate
list of tests is saved for each of the possible test frequencies. Tests are categorized and flagged as
requiring intervention or not. If tests requiring intervention are scheduled, the operator has the option
of omitting the tests if the operator does not respond within a specified time after an initial prompt is
displayed and before the test is started. Events are logged in the analyzer log for all starting, ending,
and omitted tests.

Field or Button Description

Available Tests
[drop-down box]

Select one or more tests to run unattended.

Insert [button] Inserts the selected test in theAvailable Tests drop-down list.

Skip these tests if the
operator does not
respond within [n]
minutes [check box]

Check this option if any test requiring operator intervention should be
omitted if the operator does not respond within the specified time.

Schedule Diagnostics Test Frequency Fields and Buttons Table
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Field or Button Description

Start test sequence if
instrument is idle any
time between 00:00:00
and 00:00:00 [text box]

Enter a from and to time for an unattended test to begin if the instru-
ment is idle at any time during the entered time frame.

Test Frequency [selec-
tion]

Select how often the test is to run unattended.

Test Sequence
[group box]

Provides the test file identification and estimated run time. A
checkmark in the Intervention Required column indicates that operator
intervention is required.

To remove a test from the sequence, select the test, then clickDelete.

To add a test to the test sequence, highlight a row in the Test
Sequence box, select a test from theAvailable Tests list, then click
Insert.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Schedule Diagnostics Test Frequency Fields and Buttons Table (continued)

DIAGNOSTIC TEST REPORT
Unit [n] > Diagnostics > Diagnostic Test Report
Displays previously run diagnostic service tests. Separate directories store tests run once, daily,
weekly, andmonthly. Diagnostic test report files have a .SVT file extension and are stored in the
...\Service directory.

Diagnostic Test Report
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8 Diagnostics

SAVE FILES FOR PROBLEM DIAGNOSIS
Unit [n] > Diagnostics > Save Files for Problem Diagnosis
Use to compress pertinent diagnostic information into a single zip file. This file can be sent to a
Micromeritics Service Representative for problem resolution.

1. Complete the form. A default file namedDiagnostics-[date].zip is created unless another file
name is specified.

2. When the file is saved, log in to the customer portal.
3. Click theRequests tab.
4. ClickNew Request, then complete all fields.
5. To attach the zipped file, click theAttach File(s) link, then select theDiagnostics-[date].zip file.
6. ClickAdd Request to submit the problem request.
7. Return to the portal to track the progress of the problem solution.

Field or Button Description

Comment [text box] Enter information that would be helpful to theMicromeritics rep-
resentative. If the computer is not connected to the internet, complete
this field. If the computer is connected to the internet, this information
can be completed on theMicromeritics Customer Support portal.

Save Files for Problem Diagnostic Fields and Buttons Table
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Field or Button Description

Include Files Add.Click to select additional files to send with this problem diagnosis.

Delete.Select the file in the Include Files box, then clickDelete to
remove the file from the list.

Clear.Click to clear all files from the Include Files box.
Save As [button] Click to specify the name and location of the compressed file. Make a

note of the file name and location. This file will need to be sent to your
Micromeritics representative for problem resolution.

Micromeritics rep-
resentative [text box]

Enter the name of your Micromeritics representative. This information
will remain on the window each time files for problem diagnosis need
to be submitted (can bemodified as necessary).

User Information
[text box]

Enter information for the person to be contacted by aMicromeritics rep-
resentative. This information will remain on the window each time files
for problem diagnosis need to be submitted (can bemodified as neces-
sary).

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Save Files for Problem Diagnostic Fields and Buttons Table (continued)

Save Files for ProblemDiagnosis
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9 CALIBRATION
Unit [n] > Calibration
A calibration file was created specifically for the analyzer and included with the accessories. It is not
necessary to recalibrate the system unless it seems out of calibration.

Disabled calibrationmenu options can be accessed only with the assistance of an authorized
Micromeritics service representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go toUnit [n] > Unit Configuration.

Generally it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

CALIBRATE THE LOW PRESSURE SERVO
Unit [n] > Calibration > Low Pressure Servo

Ensure the pressure transducer was calibrated by a service technician before starting
this process.

This procedure will calibrate the servo valve to the pressure transducer.

9 Calibration

AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017 9 - 1



9 Calibration

CALIBRATE SIGNALS
Unit [n] > Calibration > Signals

During calibration, the capacitance detectors, vacuum gauge, reference gauge, transducer, etc. are
read. Analysis cannot be started while the calibration window is open.

Tomanually enter calibration data, click the button containing the value to be changed and enter the
data on the popup window.

Field or Button Description

Low Pressure Reading.Displays the current values from each capacitance detector.

Low Cal. Displays the capacitance of the reference device with the
lower value.

Hi Cal.Displays the capacitance of the reference device with the
higher value.

Calibrated. The date the capacitance detector was last calibrated.

Raw Count. The digital value produced by the analyzer for each
capacitance detector.

Vac µmHg.

l Reading. The current value from the vacuum gauge.
l Low Cal. The pressure value read on a reference vacuum gauge
after vacuum is achieved.

l High Cal. The pressure value read on a reference vacuum gauge
when higher pressure is applied.

Calibration Signals Fields and Buttons Table
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Field or Button Description

l Calibrated. The date the vacuum gauge was last calibrated.
l Raw Count. The digital value produced by the analyzer for the
vacuum gauge.

50 PSIA

l Reading. The current value from the 50 psia transducer.
l Low Cal. The pressure value read on a reference transducer after
vacuum is achieved.

l High Cal. The pressure value read on a reference transducer
when higher pressure is applied.

l Calibrated. The date the 50 psia transducer was last calibrated.
l Raw Count. The digital value produced by the analyzer for the 50
psia transducer .

High Pressure Reading.Displays the current values for the left and right capacitance
detectors.

Low Cal. Displays the left and right capacitance detectors of the
reference device with the lower value.

Hi Cal.Displays the capacitance of the left and right capacitance
detectors with the higher value.

Calibrated. The date the left and right capacitance detectors were last
calibrated.

Raw Count. The digital value produced by the analyzer for left and
right capacitance detectors.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 2 - 3.

Calibration Signals Fields and Buttons Table (continued)

Calibrate Signals
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9 Calibration

CALIBRATE THE PENETROMETER

l Sample Files on page 3 - 1

The analyzer can determine sample density, or planning to use blank correction by formula), the
calibrated empty volume of each penetrometer must be entered in the penetrometer properties file.
The file can then be selected and used for analyses.

It is not necessary to determine a penetrometer’s volumemore than once, if the penetrometer and
seal are kept together and a record ismaintained.

To calibrate a penetrometer, perform a low pressure run with no sample. This fills the penetrometer
with mercury, so that its volume can be determined.

1. Create a sample file. A sample file must be created to run a low pressure analysis, even
though no sample is in place.

2. Go to File > Open > [.SMP] file. Enter the file name to be used for the calibration. If planning
to use blank correction files, seeCombine a Penetrometer Calibration and Blank Cor-
rection File on page 3 - 7. Follow the prompts to create and save the new file.

3. When creating the sample file:

On theSample Description tab:

l select thePenetrometer Properties file that corresponds to the size and type of pen-
etrometer to be calibrated, and

l enter 0 in theSamplemass field.

On theAnalysis Conditions tab:

l edit the pressure table, if necessary, and
l if this low pressure run will not be used as a part of a blank correction file, enter 1 in the
Filling pressure field,. Use 1 pressure point at 15 psia.

4. Perform the low pressure analysis (seePerform a Low Pressure Analysis on page 5 -
11).

5. Clean the penetrometer (seeClean the Penetrometer on page 5 - 5) if you do not plan to
perform the high pressure analysis and use these data for a blank correction file.

6. Repeat this process three times, recording values on worksheet. Average the volumes res-
ulting from the low pressure run.

7. Create aPenetrometer Properties file for this penetrometer (seePenetrometer Properties
on page 4 - 9). Enter the calibrated volume in the volume field.
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LOAD CALIBRATION FROM FILE
Unit [n] > Calibration > Load from File [button]
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved usingUnit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration file,
a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten each
time a new one is created.

Changing the calibrationmay affect the analyzer’s performance.

SAVE CALIBRATION TO FILE
Unit [n] > Calibration > Save to File [button]
Use to save the current calibration settings to a backup file which can later be reloaded usingUnit 
[n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be changed.
The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 is the analyzer serial number
2013-04-25 is the date the calibration file was saved
.CAL is the file name extension

Load Calibration from File
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10 HARDWARE COMPONENTS AND ACCESSORY
INSTALLATION

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

INSTALL A PENETROMETER IN A HIGH PRESSURE CHAMBER

Before opening the high pressure chamber, check the status display to ensure the sys-
tem is not pressurized.

1. Turn the vent valve slowly counter-clockwise to release excess pressure.
2. Unscrew the chamber plug assembly by turning the arms counter-clockwise. Lift the chamber

plug assembly as far as it will go. The chamber assembly contains a latching device which
automatically locks into place when the assembly is in the topmost position.

3. Gently lower the penetrometer assembly, bulb down, into the chamber until it rests firmly on
the banana plug.

4. Verify that the oil in the high pressure chamber just covers the ledge inside the chamber. Add
more oil, if needed. SeeSeal the High Pressure Chamber on page 11 - 19 andMaintain
High Pressure Fluid Level on page 11 - 18.

10 Hardware Components and Accessory Installation
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10 Hardware Components and Accessory Installation

5. Pull the latch release down to unlock the chamber plug assembly.Gently lower the assembly
while ensuring that the penetrometer is inserted into the assembly hole.After making sure the
penetrometer goes into the hole, lower the assembly the rest of the way and screw the cham-
ber plug in.

6. After the chamber plug is screwed, check the fluid level in the plastic cup above the vent valve.
to ensure all the air bubbles are out of the chamber, and sealing the vent valve. SeeSeal the
High Pressure Chamber on page 11 - 19.
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INSTALL A PENETROMETER IN A LOW PRESSURE PORT
If fewer than four samples are to be analyzed, a blank rodmust be installed in each unused low
pressure port.

If a penetrometer or blank rod is not installed in each port, vacuum conditions cannot be
achieved and an analysis cannot be performed.

1. Remove the capacitance detector from the low pressure port by turning it counter-clockwise
and pulling forward. Place it on top of the analyzer or stand it on the surface next to the high
pressure chamber.

2. Turn the retaining knob counter-clockwise until it turns with little resistance.

Do not remove the knob; internal componentsmay becomemisaligned.

3. If the low pressure port contains a blank rod, remove it. If it contains a penetrometer, see
Remove a Penetrometer from a Low Pressure Port on page 10-6.

Install a Penetrometer in a Low Pressure Port
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10 Hardware Components and Accessory Installation

4. If using a 3 cc penetrometer, install the spacer over the penetrometer stem. Insert the pen-
etrometer stem into the port and push it in as far as it will go. The spacer is required for the 3 cc
penetrometer only.

5. Tighten the retaining knob by turning it clockwise until the penetrometer is firmly seated. Do
not tighten with excessive force.

6. Install the capacitance detector over the penetrometer and turn clockwise to tighten.
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REMOVE A PENETROMETER FROM A HIGH PRESSURE CHAMBER

When analysis is finished, ensure the high pressure system indicator PRESSURIZED is
not lit.

1. Loosen the vent valve counter-clockwise approximately 1/8 turn tomake the plug removal
easier.

2. Unscrew the chamber plug by turning the arms counter-clockwise. Lift the plug assembly as
far as it will go. Fluid begins to drain from the vent valve. Pause a few seconds to allow fluid to
drain back into the chamber.

3. Remove the penetrometer assembly. Hold it over the chamber for a few moments to allow the
high pressure fluid to drain.

4. Clean the penetrometer. SeeClean the Penetrometer on page 5 - 5.

Remove a Penetrometer from aHigh Pressure Chamber

AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017 10-5



10 Hardware Components and Accessory Installation

REMOVE A PENETROMETER FROM A LOW PRESSURE PORT
1. Ensure the low pressure ports have returned to near atmospheric pressure and theHg

Drained indicator on the front analyzer panel is illuminated.

Removing penetrometers when theHgDrained indicator is not illuminatedmay allow
mercury to spill from the port. SeeDrain the Low Pressure System on page 11 - 10.

2. Hold the retaining knob to prevent rotation, then turn the capacitance detector counter-clock-
wise to loosen and remove it.

3. Turn the retaining knob counter-clockwise, then carefully withdraw the penetrometer
assembly. Do not pull on the penetrometer cap.

As the penetrometer is withdrawn, tilt the bulb end down and the stem end up, so
mercury does not spill from the open stem end.

4. Remove the penetrometer spacer if used.

If the assembly is not to be placed immediately in the high pressure chamber, store it
with the stem upward so that none of themercury will be spilled. The rack for full
penetrometers (part number 962-25827-00) can be used for this purpose.
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5. Weigh the penetrometer assembly (remove the spacer first) if density calculations are to be
made or blank correction by formula is used. Record thismass on theSample DataWork-
sheet.

Do not wait an extended period of time before performing the high pressure run.
Mercury remaining in contact with the sample for long periods of time after the low
pressure analysismay oxidize and reduce the reproducibility of results.

Remove a Penetrometer from a Low Pressure Port
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11 MAINTENANCE AND TROUBLESHOOTING

The equipment images in this document may differ slightly from your equipment, how-
ever the instructions are the same unless otherwise noted.

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time.When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided:

Log in to your customer portal to access error messages. Parts and accessories can be found online
at www.Micromeritics.com.

Status display is too large for computer monitor.

Cause: Monitor resolution is set below 800 × 600.

Action: Refer to the computer operating systemmanual to reset themonitor resolution
at or above 800 × 600.

Difficulty attaining adequate vacuum conditions during low pressure analyses.

Cause A: Vacuum pump oil is low.

Action A: Add vacuum pump oil.

Cause B: Vacuum hose not properly connected.

Action B: Ensure the connection to the vacuum pump is good and that external clamps
are tight.

Cause C: Sample contains excessmoisture adsorbed from atmosphere.

Action C: Prepare samples (prior to loading penetrometer) by heat and/or vacuum to
removemoisture.

Never heat a sample that has contactedmercury.

Cause D: Proper sealing not achieved on penetrometers

Action D: 1. Use blank rods to test the ports to eliminate the possibility of having a leaking
penetrometer cap / bulb seal.

2. Lightly grease the rodswith a high grade vacuum grease, then insert the
rods in the low pressure ports.

11Maintenance and Troubleshooting
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11Maintenance and Troubleshooting

3. Tighten the retaining knobs on the low pressure ports. If vacuum conditions
are satisfactory, check the penetrometer for scratches or chips in the bulb.

Cause E: Scratches or other imperfections in either the lip of the penetrometer bulb or the
penetrometer cap.

Action E: 1. Polish the lip of the bulb and the cap using 600 grit emery paper or crocus
cloth.

2. Place the paper or cloth on a flat surface, grit-side up.
3. Clean all grease from the surface to be polished with solvent.
4. Lightly press the surface down on the grit and rub in a circular motion. A

minute of this polishing action is usually sufficient, but it must be continued
until the surface is free from flaws. Examination of the surface under low
magnification (approximately 20X) helps determine when the surface is free
from flaws.

5. Clean the ground surface before regreasing.

Cause F: Leaking valves.

Action F: Check the valves for leaks. SeeCheck Valves for Leaks on page 11 - 29.
CauseG: Moisture has accumulated in the system.

Action G: Remove the accumulatedmoisture. SeeRemove Moisture from the Ana-
lyzer on page 11 - 31.

The low pressure analysis is complete and the system has returned to near atmosphere,
but the mercury drained indicator is not illuminated.

Cause A: Indicator is not working properly.

Action A: Verify the state of themercury degasser by looking at the status display win-
dow. If the status display does not agree with the indicator, the indicator may not
be working properly. Contact your Micromeritics service representative.

If the status display window shows that themercury has overfilled (the alarm
state), seeHandling Mercury Overfill on page 11 - 21. If the status display
shows that themercury degasser is either filled or partially filled, seeDrain the
Low Pressure System on page 11 - 10.

Cause B: Mercury is not drained. Status display shows either filled or partially filled.

Action B: SeeDrain the Low Pressure System on page 11 - 10.

Mercury warning buzzer sounds in pulses. (Mercury overfill).

Cause: Mercury detected by overflow sensor in low pressure port system.

Action: SeeHandling Mercury Overfill on page 11 - 21.
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Mercury warning buzzer sounds with continuous tone.

Cause: Mercury has been improperly drawn into themercury trap.

Action: Drain excessmercury into the reservoir. SeeHandling Mercury Overfill on
page 11 - 21. Remove the plug extending down from themercury trap. The
plug is reached through the front door. Facing the analyzer, the plug is in the
upper back right corner. SeeDrain Spilled Mercury Dish on page 11 - 11.
Position a container beneath the trap before removing the plug.

The high pressure system failed to attain the specified pressure.

Cause: Low fluid level in the hydraulic pump.

Action: Add fluid to the hydraulic pump. SeeMaintain Hydraulic Pump Fluid Level
on page 11 - 23.

High pressure system failed to retain a reasonably constant pressure.

Cause: Leakage around the high pressure chamber cap.

Action: Replace the cup seals and backup rings on the high pressure chamber cap.
SeeReplace Chamber Cup Seals on page 11 - 21.

Cannot attain low pressure data points above atmospheric pressure.

Cause: Gas supply pressure too low.

Action: Verify gas supply regulator is set to 40 to 45 psig (276 to 310 kPa) and that there
is sufficient gas in the supply bottle.

11Maintenance and Troubleshooting
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11Maintenance and Troubleshooting

SYSTEM COMPONENTS

LOW PRESSURE SYSTEM COMPONENTS

Item # Component Description

1 Servo isolation
valve

Ensures no leaking occurs through the servo. It is open when the
servo is in use and closed when the servo is off.

2 Fast evacuation
valve

Used at the end of the evacuation routine to achieve the best
vacuum.When this valve is open, the sample stations are directly
connected to the vacuum system.

3 Vacuum valve The vacuum valve is opened to evacuate the back of the servo
valve during the ramping part of the evacuation sequence. This
allows the servo valve to control the evacuation rate.

When the pressure is low enough, the evacuation through the
reservoir proceeds. This is accomplished by alternately opening
Valve 8 (to allow gas from the sample tomove to the reservoir)
and Valve 3 (to evacuate the reservoir for the next step).

Low Pressure System Valves
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Item # Component Description

4 Gas inlet valve Allows pressurization at the back of the servo valve. The servo can
then be used to dose pressures from 0.2 psia to 50 psia onto the
low pressure stations. Dry nitrogen or argon is the preferred gas.
Do not use air unless it is dried to remove water vapor.

5 Mercury fill valve Mercury flows into the degasser then into the low pressure sta-
tions and is controlled by the fill valve. The drain valve allowsmer-
cury to flow back into the reservoir.

6 Drain valves SeeMercury fill valve [5].

7 Mercury reservoir
evacuation valve

Connects the vacuum line to themercury reservoir.

8 Evacuation Reser-
voir valve

See Vacuum valve [3].

Low pressure ports A sample encased in a penetrometer is first evacuated, filled with
mercury, then pressurized to between 15 and 50 psia.

Penetrometer stems inserted into a station are sealed for vacuum
and against mercury leakage by compression of a soft, gum
rubber cylinder near the tip. The rubber is compressed by turning
the large knob or pressure collar that protrudes from the front. The
inner rim of this knob serves also as themountingmechanism for a
capacitance transducer after the knob has been tightened.

Mercury storage reservoir Holds 7 to 10 pounds of mercury and is located behind the front
panel. The level of mercury is visible through a small window in the
front panel. Before beginning a low pressure analysis, the applic-
ation verifies that the level of mercury in the reservoir is adequate.

Mercury degasser Removes trapped gases asmercury passes to low pressure
stations then into the penetrometer.

HG Up indicator. Illuminateswhenmercury level fills the
penetrometers. The sensor completes an electric circuit and flow

Low Pressure System Valves (continued)

Low Pressure SystemComponents
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11Maintenance and Troubleshooting

Item # Component Description
is stopped by closure of themercury fill solenoid valve.

Drained indicator. Illuminateswhen themercury drain valve is
closed and the level of mercury in the degasser is below the level
in the low pressure stations.

Alarm buzzer. If the level of mercury rises above the normal filling
level, the sensor causes both themercury fill valve and the
mercury drain valve to close and a buzzer alarm sounds. See
Handling Mercury Overfill on page 11 - 21.

Mercury trap Serves as a large volume reservoir for mercury in the event that
operator error or amalfunction allowsmercury to travel toward the
vacuum system. If not stopped, mercury can severely damage the
analyzer. Should this occur, a high-pitched, continuous alarm
sounds if more than 6mm (0.25 in.) of mercury accumulates in the
trap. The fault must be corrected and themercury removed before
proceeding.

Low Pressure System Valves (continued)
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HIGH PRESSURE SYSTEM COMPONENTS

Component Description

High pressure chamber The two high-pressure chambers are closed by the chamber plug
assemblies. These are sealed into the chambers with large threads
and tightened by turning two short handles. The closure components
are counter-sprung so that they are readily raised and lowered. On top
of each closure is amanual valve for venting or purging air that may be
trapped when a high pressure chamber is closed.

High Pressure System Components

High Pressure SystemComponents
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11Maintenance and Troubleshooting

Component Description

Hydraulic pump The basic high-pressure generating unit is a hydraulic pump. The
pump has a hydraulic fluid reservoir and a pressure gauge. The relief
valve limits themaximumpressure to 2800 psia. The pump and drive
motor rotation are reversible to allow the pressure adjustment.

Pump speed and direction are controlled by the application which
prevents overshooting of the target pressure while minimizing time
required to attain a target pressure.

Pressure intensifier The required psia is generated by a double- action, dual piston intens-
ifier connected to the hydraulic pump. Two limit switches are located
near the upper and lower limits of piston travel. The first of these
switches alerts the operating program; the second interrupts the
power to themotor.

Transducer High pressuremeasurements aremadewith one pressure transducer.
The signal from this transducer is processed by electronic circuitry to
yield two pressure output signals.

High Pressure System Components (continued)
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CHANGE THE FUSES
Fuse the input power line according to local safety practices. The input power connector can be used
with either a single-fuse arrangement or a double-fuse arrangement.

The power cord should be disconnected from the analyzer before removing the cover
from the power input connector. Failure to disconnect the power cord could result in elec-
trical shock.

l If the single-fuse arrangement is needed, position the fuse block so that the side with the single-
fuse slot and the jumper bar is away from the cover.

l If the double-fuse arrangement is needed, position the fuse block so that the side with the double-
fuse slots is away from the cover.

1. Reposition the fuse block, if necessary:
a. Remove the fuse block retaining screw.
b. Lift the fuse block from the cover.
c. Rotate the fuse block.
d. Mount the fuse block to the cover.
e. Replace the retaining screw.

2. Insert appropriate fuse for the input power source. Refer to the chart below for the appropriate
fuse rating.

The fuse used in the analyzer must be identical in type and rating to that specified. Use
of other fuses could result in electrical shock and/or damage to the unit.

Power Source Fuse

100-120 VAC 3AG6.25 AmpSlow-Blow

200-240 VAC 5 x 20mm5.0 AmpSlow-Blow

3. Insert fuse block and cover assembly into input power connector and snap it into place. After
the fuse block and cover assembly are in place, the position of the indicator pin shows the
input power selected.

Change the Fuses
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11Maintenance and Troubleshooting

4. Connect the power cord to the analyzer and plug into an appropriate power source.

DRAIN THE LOW PRESSURE SYSTEM
Unit [n] > Generate Low Pressure

1. Specify a pressure of 10 psia. After the system reaches 10 psia and returns to Idle status,
open the reservoir evacuation valve (#7) for 20 seconds.

Ensure the fill cap is sealed before proceeding. SeeMaintain Mercury Level on page 11 -
17.

2. Open themercury drain valve until themercury drains.
3. Close themercury drain valve.
4. Close themercury reservoir evacuation valve.
5. To return the system to atmosphere, go toUnit [n] > Generate Low Pressure and enter a

pressure of 15 psia.

If the system still indicates that themercury is not drained (the status display, themer-
cury drained indicator or both), seeHandling Mercury Overfill on page 11 - 21.
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DRAIN SPILLED MERCURY DISH
A dish for collectingmercury is located just behind the high pressure chambers. Pour approximately
1.0 to 2.0 cc of oil into the dish to prevent themercury from vaporizing.

If mercury accumulates in the dish, remove it by removing the cover and extracting themercury with
the syringe accessory.

Approximately 3mm (1/8 in.) of oil should remain in the container to prevent the escape
of mercury vapors.

Drain SpilledMercury Dish
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ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

Use to enable themanual control of certain system valves and elevator components on the analyzer
schematic. When this option is enabled, a checkmark appears to the left ofUnit [n] > Enable
Manual Control.

If the analyzer schematic is not immediately visible, go toUnit [n] > Show Instrument Schematic.

Schematic
Components

Description

1 Servo isolation valve

2 Fast evacuation valve

3 Vacuum valve

4 Gas inlet valve

5 Mercury fill

6 Mercury drain

7 Mercury reservoir evacuation

8 Evacuation reservoir

Schematic Components Table
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Schematic
Components

Description

A Mercury reservoir

B Mercury degasser

C Mercury trap

D Intensifier

E Hydraulic pump

Pressure l Displays the current pressure in the system.
l The pressure is shown in the units selected inOptions > Units.
l The reading shown is from either the vacuum gauge or the 50 psia trans-
ducer, depending upon which is currently in range.

Status Provides the sample file name and sequence number, the intrusion volume,
and the percent of the penetrometer stem already used.

Schematic Components Table (continued)

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve.

Servo Valve. Closed.

Servo Valve. Open.

Analyzer Schematic Icon Table

EnableManual Control
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11Maintenance and Troubleshooting

Mercury Degasser. Displays themercury level.

Drained Partially Filled Filled Overfilled. This alarm
displays

with a red background.
This is an alarm state.

Mercury Trap.Displays the state of themercury trap.

Empty Containsmore than 6mmof mercury.
This is an alarm state.

Mercury Reservoir.Displays the level of mercury in the reservoir.

If themercury level is low, seeMaintain Mer-
cury Level on page 11 - 17.

Level is OK.

Low Pressure Schematic Icons
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Hydraulic Pump
When the pump is operating, the target pressure
displays below the icon. A green icon indicates the
pump isON. A yellow icon indicates the pump is
OFF. To set the target pressure when the icon is
yellow, either double-click the pump icon or right
click the icon and selectSet.

Intensifier. Displays the state of the intensifier limit switches.

Midway Top Bottom

High Pressure Schematic

EnableManual Control
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11Maintenance and Troubleshooting

PREVENTIVE MAINTENANCE

Perform the following preventivemaintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventivemaintenance procedures and
calibration be performed by aMicromeritics Service Representative every 12months.

Maintenance Required Frequency

Banana plug Check every 600 samples or 3months. Replace as needed.

Chamber plug seals Replace every 600 samples or 3months.

High pressure chambers Check and clean every 600 samples or 3months.

High pressure fluid Check every 600 samples or 3months.

High pressure fluid level Check prior to performing a high pressure analysis. Fill as
needed.

Hydraulic pump fluid Check every 6months. Fill as needed. Change annually.

Low pressure ports Grease every 600 samples or 3months.

Mercury dish Check daily for spills. Service as needed.

Mercury level Service daily.

Mercury vapor filter Replace annually.

Moisture in system Remove as needed.

Vacuum pump exhaust filter Replace every 600 samples or 3months.

Vacuum pump fluid Change every 1200 samples or 3months.

Vacuum pump fluid level Checkmonthly. Fill as needed. Refer to the vacuum pump
user manual for instructions.

Valves Check for leaks and clean as needed.
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MAINTAIN MERCURY LEVEL
Each analysismay extract from 3 to 15mL of mercury from the reservoir depending on the
penetrometer and sample size used.When running a low pressure analysis, a pop-upmessage
displays on the Low Pressure Analysiswindow when the level of mercury drops below theminimum
level. Themercury level should be within 0.5 to 1.0 in. (1 to 3 cm) below the top of themercury
viewing window. It must never reach above the viewing window. To avoid delays, check themercury
level, addingmercury when necessary, at the beginning of each day.

Ensure the use of triple distilledmercury that is at least 99.999% pure.

The analyzer requires approximately 5 lbs of mercury (minimum) to begin analyses. Do not usemore
than 10 lbs.

A spilled-mercury container, located in the center of the analyzer work surface behind the high
pressure chambers, is provided so that any accidentally spilledmercury can be immediately brushed
into it. Pour approximately 1.0 to 2.0 cc of oil into the container to prevent themercury from
vaporizing.

1. Remove themercury reservoir cap.
2. Slowly pour themercury into the reservoir to within 0.5 to 1.0 in. (1 to 3 cm) from the top of the

viewing window.
3. Replace the reservoir cap.

Maintain Mercury Level
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Overfillingmay interfere with the vacuum system. Reservoir cap should be finger tight
only.

Ensure that themercury filling funnel is tightly secured. If it is necessary to tighten the fun-
nel, use an appropriate tool. If the funnel is not tightened, there could be a gas leak and
the vacuumwill not pull properly.

MAINTAIN HIGH PRESSURE FLUID LEVEL
The high pressure fluid level in the high pressure chamber should be checked when preparing for a
high pressure analysis. The fluid level should be up to the ledge when a penetrometer is installed.
Add high pressure fluid as needed.
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SEAL THE HIGH PRESSURE CHAMBER

High pressure fluid leaking past the chamber seal indicates one of three problems:

l Toomuch fluid. Remove fluid, clean the seal and try again.
l Damaged seal. Replace the seal, then try again.
l Fluid in the threads. Clean and reseal.

The chamber plug seals the high pressure chamber. Proper sealing does not require the use of
excessive force. The outside diameter of the elastic seal on the plug is slightly larger than the inner
diameter of the pressure chamber. Lowering the chamber plug into the pressure chamber presses
the seal against the chamber wall, sealing the chamber. Then, as pressure increases during an
analysis, the outer lip of the seal is forcedmore tightly against the chamber wall, preventing leakage.

1. Push the plug into the chamber until it contacts the chamber shoulder. Several threads of the
plug will remain exposed.

2. Ensure the vent valve is partially open (unscrewed). Slowly turn the plug clockwise into the
chamber to force air from the chamber. Continue turning until high pressure fluid (or air
bubbles and fluid) appears in the transparent cup on top of the vent valve.

Tightening the plug too quicklymay cause unwanted intrusion caused by pressure cre-
ated when the chamber is closed.

3. The cup should not be completely full. If the cup is too full, slowly open the chamber and
recheck the fluid level. Fluid may need to be removed. SeeMaintain High Pressure Fluid
Level on the previous page for instructions on how to remove excessive fluid. Repeat the
previous steps to release trapped air.

Seal the High Pressure Chamber

AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017 11 - 19
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l Large air bubblesmay be caught in the chamber. Slowly loosen and tighten the plug
approximately 1/2 turn several times. This should cause any air bubbles to rise through the
transparent cup to the surface. Any remaining tiny bubbleswill not affect the analysis.

l If no fluid is visible in the cup when the plug is fully tightened, open the chamber and
recheck the fluid level. It is likely that fluid may need to be added. Repeat the previous
steps to release trapped air.

Small amounts of high pressure fluid can be added to or removed from the cup on top of
the vent valve without opening the chamber. To do so, remove the cap and use appro-
priate tools, such as a syringe.

GREASE LOW PRESSURE PORTS
The screw threads visible behind each low pressure port retaining knob should be greasedmonthly.

1. Remove the capacitance detectors by turning counter-clockwise.
2. Remove the plastic caps.
3. Unscrew the retaining knobs until the threads disengage.

4. Lubricate the retaining knob threads andmating surfaceswith amedium consistency grease
such aswhite lithium grease.

5. Screw the retaining knobs back into the low pressure ports.
6. Replace the plastic caps and capacitance detectors.
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HANDLING MERCURY OVERFILL

1. On theManual Control window, open the reservoir evacuation valve. Evacuate for twenty
seconds.

TheHg reservoir evacuated indicator should be displayed on the analyzer schematic. If it is not
shown, do not proceed to the next step. Instead, verify that themercury reservoir fill cap is
properly sealed on top of themercury filling funnel (seeMaintain Mercury Level on page 11
- 17). If theHg reservoir evacuated indicator still is not displayed, contact aMicromeritics
Service Representative.

2. Open the gas inlet valve. Close the gas inlet valve when at least 15 psia or atmosphere is
attained.

3. Open themercury drain valve.
4. Open the front panel of the analyzer and locate theOverride switch on the small control

panel.
5. Press the switch. This allowsmercury to drain back into the reservoir.
6. Release the switch as soon as the pulsed buzzing stops. Close themercury drain valve.
7. Close the reservoir evacuation valve. If the pulsing tone remains, call theMicromeritics Ser-

vice Department. The analyzer may be powered off.

REPLACE CHAMBER CUP SEALS
The chamber plug is sealed into the high pressure chamber bymeans of a cup seal and a backup
ring. There is also anO-ring in the vent valve. See Replace the Vent Valve O-ring on the next
page.These rings should be checkedmonthly and replaced when the backup ring extrudes, small
slivers come from the cup seal or backup ring, or pinched areas appear on the cup seal. The rings
may also need replacing when oil appears around the top of the chamber or when it is difficult to
maintain pressure in the high pressure chamber

1. Remove the chamber cup seal and backup ring without scratching the surrounding surfaces.

HandlingMercuryOverfill
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2. Replace the backup ring on the lower portion of the chamber plug with the backup ring upper-
most and with the groove of the cup seal downward.

3. Replace theO-ring in the vent valve.

REPLACE THE VENT VALVE O-RING

1. Remove the vent valve from the top of the high pressure chamber by turning the vent valve
counter-clockwise.

2. Gently remove theO-ring on the vent valve and replace with a new one.
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CHANGE HIGH PRESSURE FLUID AND CLEAN HIGH PRESSURE
CHAMBER
The high pressure fluid should be changed after every 600 samples or 3months to ensure accurate
results. It should also be changed if mercury is spilled into a high pressure chamber. Small drops of
mercury in the bottom of the chamber can cause erroneous results.

1. Remove the high pressure fluid from the high pressure chambers using the syringe provided.
2. Clean the high pressure chambers using a clean cloth dampened with IPA.
3. When the chambers are completely dry, add new high pressure fluid.

MAINTAIN HYDRAULIC PUMP FLUID LEVEL

When changing the hydraulic pump fluid, use onlyMobil-1 50W-50 SyntheticMotor Oil
(Micromeritics part number 004-16011-00).

The hydraulic pump fluid container is located in the lower left corner inside the analyzer's front door.

Check the fluid level when the intensifier on the schematic is in the down position. Add fluid as
necessary to keep the fluid level near the top of the container.

Change High Pressure Fluid and Clean High Pressure
Chamber
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Filling the fluid container when the intensifier is in the up position can cause the fluid to
overflow the when intensifier is lowered.

To add fluid to the container, remove the cap to the fluid container and add fluid as necessary.
Replace the cap when done.
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VACUUM PUMP

REPLACE VACUUM PUMP EXHAUST FILTER

The exhaust filter is attached to themercury vapor filter on the vacuum pump.

1. Loosen the wing nut that secures the clamp between the exhaust filter and themercury vapor
filter by turning the nut counterclockwise. Open the clamp and remove it, the centering ring,
and the exhaust filter.

2. Inspect the centering ring for wear and replace if necessary.
3. Align the centering ring between the replacement exhaust filter and themercury vapor filter.
4. Open the clamp and place it around the lip of the exhaust filter, mercury vapor filter, and cen-

tering ring.
5. Close the clamp and secure it by turning the wing nut clockwise. Tight the wing nut finger tight.

VacuumPump
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11Maintenance and Troubleshooting

REPLACE THE MERCURY VAPOR FILTER

Mercury vapor filters are used on vacuum pumps tominimize the release of mercury
vapors.

Themercury vapor filter should be replaced annually when preventivemaintenance is
performed.When themercury exhaust filter is replaced, go toUnit [n] > Show Dash-
board. Right click theDays until Hg filter replacement is due box and clickReset. The
counter resets to 365 days until the next filter change is due. ServiceMode and pass-
word are required tomake this change.

1. Loosen the wing nut that secures the clamp between the exhaust port and themercury vapor
filter by turning the nut counter-clockwise.

2. Open the clamp and remove it.
a. Remove the protective cover if this is an initial installation.
b. If this is not an initial installation, remove and inspect the centering ring for wear and

replace if necessary.
3. Align the centering ring between themercury vapor filter and the exhaust port.
4. Open the clamp and place it around the lip of the exhaust port, mercury vapor filter, and cen-

tering ring.
5. Close the clamp and secure it by turning the wing nut clockwise. Tighten the wing nut finger

tight.
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CHANGE OR ADD VACUUM PUMP OIL

Drain the oil while the pump is warm and disconnected from the power source.

The pumpmust be removed from the analyzer to change the oil. Use oil supplied byMicromeritics or
refer to the vacuum pumpmanual for other acceptable oils.

1. Unplug the vacuum pump from the power source.
2. Remove the exhaust filter by loosening the wing nut on the clamp between the vacuum pump

exhaust filter and themercury vapor filter.
3. Remove the centering ring and place to the side.
4. Remove the vacuum hose from the vacuum pump by loosening the wing nut on the clamp

between the vacuum pump and the vacuum hose.
5. Remove the centering ring and place to the side.
6. Remove the pump from inside the analyzer.
7. Remove the vacuum pump from inside the analyzer .
8. at the top of the oil vapor trap. Swing the clamp open and remove the trap from the hose.
9. Grasp the handle on top of the vacuum pump and place the pump on a work surface.
10. Place a waste container under the drain spout.

11. Remove the drain plug and drain the oil into the waste container.
12. Replace the drain plug.
13. Remove the drain plug from the oil-fill port on top of the pump.

Change or Add VacuumPumpOil
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11Maintenance and Troubleshooting

14. Slowly add oil to the port until the level ismidway between the indicator lines in the oil-level win-
dow when the pump is running.

Do not allow oil to rise above themidway position when the pump is running. Doing so
may cause oil to splash into the oil filter causing contamination.

15. Check the washer or O-ring used at the oil-filling port and replace if necessary.
16. Insert the oil-fill plug and turn clockwise to tighten.
17. Return the vacuum pump to the original position inside the analyzer.
18. Reconnect the vacuum pump hose.
19. Reconnect the exhaust filter to the top of themercury vapor filter.
20. Reconnect the power cord to the power source.
21. Turn the vacuum pump on and recheck the oil level.
22. Allow the pump to run a few hours (overnight if possible) to eliminate air andmoisture from the

fresh fluid and to produce efficient vacuum operations.
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CHECK VALVES FOR LEAKS
Valve leakage due to sample particles or oxidizedmercury deposits on valve seats can cause
difficulty in attaining adequate vacuum conditions. To test for leakage:

1. Open valves 1, 2, 3, and 8.
2. If the pressure does not reach 100 µm in less than fiveminutes, the system has a leak. If this

occurs, clean the valves. SeeClean Valves below.

CLEAN VALVES

Ensure all mercury is below drain valves. Evacuate the reservoir and open the drain and
fill valveswith the low pressuremanifold at atmospheric pressure. Failure to do so could
result in amercury spill.

Power off the analyzer before removing the rear panel. Failure to do so could result in
personal injury.

1. Disconnect the power cord.
2. Remove the upper rear panel by removing the retaining screws.

Check Valves for Leaks
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11Maintenance and Troubleshooting

3. Remove the 11/16 in. nut retaining the valve actuating coil from themercury fill [5] and drain [6]
valves. Pull the coils off.

Valve Location Description

1 Servo isolation valve

2 Fast evacuation valve

3 Vacuum valve

4 Gas inlet valve

5 Mercury fill valve

6 Mercury drain valve

7 Mercury reservoir evacuation valve

8 Evacuation reservoir valve

Valve Locations

4. Place a container below the valves to capture any retainedmercury.
5. Remove the plunger housing from each using the special spanner wrench from the accessory

kit.
6. Clean the plunger and housing with IPA and expose the valve seat. Use a pipe cleaner to

clean the valve seat. Ensure that no lint remains on the sealing surface.
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7. Re-assemble the valves.
8. The slow / medium, medium, and fast evacuation valves, and the gas inlet solenoid valve are

much less likely to collect debris. They can be cleaned (as outlined above) if cleaning themer-
cury valves did not solve the vacuum difficulty.

CLEAN THE ANALYZER
The exterior casing of the analyzer may be cleaned using a clean cloth dampened with isopropyl
alcohol (IPA), amild detergent, or a 3% hydrogen peroxide solution. Do not use any type of abrasive
cleaner.

Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in
damage to the unit.

REMOVE MOISTURE FROM THE ANALYZER
A difficult-to-detect vacuum problem arises if moisture is allowed to collect in the system. A probable
accumulation point is the restricting frits that control flow rates. The best way to removemoisture is to
evacuate the analyzer at full rate for several days. If the indicated vacuum continues to decrease
slowly over this period, accumulatedmoisture is the probable cause of the vacuum difficulty.

To prevent the accumulation of moisture in the future, do not evacuate sampleswhich hold
excessive water vapor. This is best done by precleaning samples in a drying oven.

Clean the Analyzer
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11Maintenance and Troubleshooting

REPLACE THE BANANA PLUG

HIGH PRESSURE CHAMBER

1. Remove the fluid from the high pressure chamber using the syringe provided.
2. Remove anymercury droplets found in the high pressure chamber. Clean the high pressure

chamber using a clean dry cloth.
3. Locate the feedthru assembly in the bottom of the high pressure chamber. Remove the

banana plug from the feedthru assembly using the banana plug tool provided.

4. Insert a new banana plug into the banana plug tool, ensuring the flat sides of the hex fit down
into the slot.

5. Screw the banana plug into the feedthru assembly. Do not cross-thread or overtighten the
banana plug.

6. Refill the high pressure chamber with clean high pressure fluid.

LOW PRESSURE CAPACITANCE DETECTOR

1. Remove the low pressure capacitance detector from the low pressure station.
2. Remove the banana plug from the low pressure capacitance detector using the banana plug

tool provided.
3. Insert a new banana plug into the banana plug tool, making sure the flat sides of the hex fit

down into the slot.
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4. Screw the banana plug into the low pressure capacitance detector.

Low Pressure Capacitance Detector
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11Maintenance and Troubleshooting

PENETROMETER NUT

REMOVE THE PENETROMETER NUT

If the penetrometer nut cannot be easily opened by hand, it may have become sealed too tightly
during analysis. Use the penetrometer wrench to remove it.

1. Place the penetrometer tool over the nut.

2. Place the wrench peg into a hole in the penetrometer nut. Use the penetrometer tool to sta-
bilize the cap while tightening the nut counter-clockwise.

3. Position the wrench so the peg on the wrench fits into the notch on the nut.
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4. While holding the penetrometer tool, turn the wrench clockwise to loosen and remove the nut.

TIGHTEN THE PENETROMETER NUT

1. Apply grease to the penetrometer bulb and remove any excess grease.
2. Hold the penetrometer upright (sample bulb opening facing upward) and place a seal on the

bulb opening.
3. Turn the seal one half turn to smooth the grease and seat the seal.

Take care not to move the seal after seating onto the penetrometer bulb. The grease
may extrude toomuch and cause an air leak.

4. Place the penetrometer tool over the nut.

Tighten the Penetrometer Nut
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11Maintenance and Troubleshooting

4. Place the wrench peg into a hole in the penetrometer nut. Use the penetrometer tool to sta-
bilize the cap while tightening the nut counter-clockwise.

POWER ANALYZER ON AND OFF

DO NOT connect or disconnect cables when the analyzer is poweredON.

Power ON the equipment in the following order:

The vacuum line from the low pressure system and the vacuum pump filter must be
installed before applying power to the vacuum pump. Refer to your vacuum pump
manual.

1. Analyzer
2. Computer, monitor, and printer

Power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data.
2. Computer, monitor, and printer
3. Analyzer

RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progresswhen
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected during
the analysis will still be present, but the analysis should be restarted in order to produce complete
results.
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A BLANK AND SAMPLE COMPRESSION CORRECTIONS
Baseline errors in AutoPore V data are errors that occur even when no sample is placed in the
sample bulb and when a zero intrusion or extrusion volume of mercury would be expected as the
pressure is increased to itsmaximumpressure and then decreased again. Thematerial which
follows relates the causes of these errors and discussesways tominimize and compensate for them
whenmaximumaccuracy is required.

BASELINE ERRORS
When the AutoPore applies pressure to themercury, penetrometer, and surrounding high pressure
oil, compression occurs.

Compressibility effects account for a substantial portion of the baseline errors. The penetrometer
bulb and capillary aremade of glasswhich decreases in linear dimensions by about 0.8% and in
volume by 2.3% at 60,000 psia. If themercury were incompressible, a typical penetrometer having a
400microliter capillary and a 5milliliter bulb would experience a rise of mercury in the capillary of
about 124microliters or 31% of the capillary. Fortunately, mercury compresses also, but slightly
more than glass such that the capillary actually falls some as the pressure is increased. The
compressibility amounts to about 150microliters in this example leaving a net fall of 26microliters or
about 6% of the capillary. The oil which surrounds the penetrometer and transmits the pressure to
themercury compresses at more than 10 times the rate of themercury and occupies only 3/4 the
original volume at 60,000 psia. Some of the oil is in the electric field of the capacitor, especially
around the sample bulb and its connection to the exterior. The dielectric constant of the oil increases
with its density. This contributes an increasing capacitance which cancels some of the decrease due
to the net fall of mercury with compression.

Other effects caused by compression arise from the plastic insulators which are used on the
penetrometer bulb base to prevent an electrical short circuit. Not only does the plastic compress
almost asmuch as the oil, but it lags behind and only slowly assumes its final density. This is
especially pronounced upon release of pressure where the plasticmay continue to increase in
dimensions for almost an hour. It also tends to increase the dielectric constant and capacitance with
increasing pressure. The pressure vessel expands as the internal pressure is increased and, like the
plastic, requires considerable time to stabilize. The resulting changes in spacing from the sample
bulb to the walls and bottom causes a decrease in capacitance. Micromeritics hasminimized this
effect bymaking the initial spacings as large as is practical.

A Blank and Sample Compression Corrections
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A Blank and Sample Compression Corrections

Another effect, and the onemost difficult to predict, arises from the similarity of the penetrometer to a
thermometer. This would not be troublesome if its temperature could bemaintained constant, but
compression of the surrounding oil causes a temperature rise of nearly 50 ºC in the oil and a smaller
change in the glass andmercury. How quickly this heat is transferred to themercury depends upon
how rapidly the pressure is being increased, the relative amounts of oil andmercury present, and
how recently the vessel has been previously cycled and themetal and oil warmed relative to the
penetrometer. Release of the pressure causes the inverse effect, chilling the oil and setting up a
reversal of the heat flow. The thermal gradient across the glass of the penetrometer may be
considerable such that little benefit may be derived from precisely equalizing the temperature
coefficients of themercury and glass. Asmight be expected this problem is worst when the sample
bulb is large and the capillary volume small. Choosing the right penetrometer helpsminimize this
effect. Make sure the sample nearlymatches the size of the sample bulb and that the capillary
volume is large enough to satisfy intrusion.

APPROACHES FOR ERROR COMPENSATION
Situations arise where the typical errors of about 1.0% of capillary volume are significant or where
the errors exceed this level due to unfavorable sample characteristics. Most commonly, this happens
when one of the following is encountered: 1) The amount of sample available is so limited that the
intrusion volume is only a small fraction of the smallest diameter capillary; 2) adequate sample is
available but the porosity is so low that a limited amount of the smallest capillary is used even though
the largest sample bulb is filled; 3) the sample is of small or moderate porosity and its compressibility
or thermal properties differ considerably from those of mercury; 4) accuracy and reproducibility
specifications have been imposed at levels tighter than the typically expected levels for mercury
porosimetry. In such cases “blank corrections” may be used to advantage.

Micromeritics’ AutoPore provides four different ways to apply blank corrections. The first, and
simplest, is by use of stored formulas based upon averages of large numbers of blank runs on
mercury-filled penetrometers under varying rates of pressure build and release. No provisions are
made for entering compressibility data or thermal data since these numbers are seldom known and
the formulaswould become very complex. Typical examples of blank runs are shown in Figures 1, 3
and 7. Typical examples of formula blank correction of data are shown in Figures 2 and 6. It is very
important that trial blank runs bemadewhen applying these formulas to ensure that a reasonable
degree of correction is actually attained under the running conditions being used.

The second technique is apt to bemuchmore useful. It permits the user to run a blank run, store the
results using the exact run conditions and penetrometer type to be used for the real sample, and
subtract this result from other runs. Examples of correction by subtracting a blank run file are shown
in Figures 4 and 8.
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The third technique provides the highest degree of compensation possible and can be attained when
the exact penetrometer to be used later is loaded with a nonporous sample of the samemass and
material as the porous sample to be run later. When analyzed, the non-porous sample will expose all
the aforementioned compressibility effects which can then be subtracted from the porous sample
run. This third technique has the advantage of compensating for differences in compressibility and
thermal effects betweenmercury and the samplematerial. Care should be exercised that the interval
between runs, oil temperature, and penetrometer temperature, and any other initial conditions are
made as nearly identical as possible. Figure 9 is a typical baseline run so obtained. Figure 10 is a
subsequent blank run corrected using the Figure 9 data and shows the actual degree of correction
attained.

Besides running blank runs, correction filesmay be created bymanually entering the data. This
fourth technique allows entry of the average of several blank runs, assuring a representative
correction.

Figure 1

A blank run on a 5-mL powder penetrometer with
a 1.1-mL stem volume. The rise in the initial
depressurization data is primarily caused by
thermal effects. As the hydraulic fluid is allowed
to expand, it cools. this in turn cools themercury
in the penetrometer, causing it to contract and
recede in the stem, giving the appearance of
positive intrusion during depressurization.

Figure 2

The difference between the blank data in Figure
1 and the formula blank correction for a run under
the same conditions. The formula cancels some
of the error, but does an imperfect job in this
case.

Approaches for Error Compensation
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A Blank and Sample Compression Corrections

Figure 3

Another blank data set taken under identical
conditions to those for Figure 1. The similarity
between the two blank data sets is an indication
of the excellent repeatability of blank runs.

Figure 4

The difference between the blank data from
Figure 1 and the blank data from Figure 3. This
demonstrates that blank data collection and
subtraction is a powerful method for accurately
removing blank error from sample data.

Figure 5

Uncorrected data from analysis of a sample of
controlled pore glassmade of amixture of three
pore sizes. Note the three distinct regions of
intrusion between 0.03 and 0.01micrometers on
the pressurization curve, and the corresponding
extrusion regions. The apparent intrusion at sizes
above 10micrometers is due to interparticle
filling. The apparent intrusion between 0.01 and
0.003micrometers, and the “loop” in the
extrusion curve from 0.04 to 0.003micrometers,
are due to a combination of sample compression
and blank error. There is no actual intrusion in
this region.

A - 4 AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017



Figure 6

The data from Figure 5 with the formula blank
correction applied. Note that the rise at the top
due to blank error has been removed, but the
apparent intrusion due to sample compression
remains. This is because the formulamakes no
attempt to account for sample compression.

Figure 7

A blank run with the same type of penetrometer
under the same conditions as the sample in
Figure 5. It is dominated by the initial increase
between pressurization and depressurization,
primarily due to thermal effects.

Figure 8

The sample data from Figure 5 corrected by
subtracting the blank data from Figure 7. Note
that practically all of the blank error and
compression data have been removed, leaving
only the filling curve and the actual intrusion. The
sample compression is effectively canceled
because the compression coefficient of mercury
is close to that of the controlled pore glass used
as sample. Many solid materials have
compression coefficient fairly close to that of
mercury, making this a very effectivemeans of
blank correction in many cases.

Approaches for Error Compensation
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A Blank and Sample Compression Corrections

Figure 9

Uncorrected data from an essentially nonporous
sample of the same type of glass shown in Figure
5. Themass of sample used was approximately
equal to themass of porous sample analyzed, so
that the same volumewas occupied. Note the
filling curve and the blank error “loop.” The slight
incline of the intermediate plateau and the angle
of the “loop” are due to compression of the
sample.

Figure 10

The difference between the porous sample data
of Figure 5 and the nonporous sample data of
Figure 9. Some of the filling curve has been
removed, aswell as all blank error and sample
compression effect, leaving an accurate picture
of the actual intrusion. This is the preferred
method of blank correction, especially for
materials with compression coefficients
substantially different from that of mercury, and
wheremaximumaccuracy is desired.
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B CHOOSE PROPER PUMP-DOWN RATES FOR UNFAMILIAR
SAMPLE MATERIALS

There are a number of characteristics of an unfamiliar sample which can aid you inmaking a proper
decision as to how aggressively the samplemay be pumped down. Some of these characteristics
are listed below. The assumption is alwaysmade that the samplematerial has been first dried in a
shallow pan at 150 ºC or higher for one hour or in a vacuum oven.

Samples, whether in the form of fine powders, granules, or even larger pieces, require extreme
caution if one or more of the following characteristics are noted or known to be the case:

l a fine dust is raised upon stirring or shaking and the sample shows little sign of quickly settling
l the sample is a finely powdered organicmaterial
l the sample is known to bemicroporous or mesoporouswith pores of less than 100 Angstrom
width

l the sample is known or suspected to be a carbon
l the sample is known or suspected to be a zeolite
l the sample is known or suspected to be a fluid cracking catalyst
l the sample has significant fine particle content below 10mm
l the sample leaves behind a visible deposit of fine particles when transferred from aweighing pan

Such samplematerials should be evacuated at initial pump down rates of about 0.5 psia/minute or
more slowly if of marked fineness until a pressure of 0.1 psia is reached. The pulsing of the second
pump down path should bemaintained until 100mmHg is reached before the final shift to the third
andmost direct pump down path takes place. The penetrometer must be filled only about 1/3 full so
that there is amargin of clearance between the stem bore and the sample bed.

Samplematerials which are coarse, medium, or dense powders, or are composed of obviously non-
shedding chunks, pellets, or extrudates, can be pumped down at rates of 1 to 2 psia per minute until
a pressure of 0.25 psia is reached. The pulsing of the second pump down path should bemaintained
until 250mmHg is reached before the third pump down path takes over.

Samplematerials that obviously present little risk such asmonolithic chunks or very coarse, dense
granules usually can be pumped down at near maximum rates. For these, specify 5 psia per minute
initial pump down followed by a change to the second path at 0.5 psia and finally a transition to the
direct path at 500mmHg.

Inmost cases, you should choose a conservative rate of evacuation to be on the safe side.When
large numbers of samples of amaterial are to be run, the potential time savingsmaymake it
worthwhile to investigate as to whether faster pump down ratesmight be possible without risk. To do
so, leave the capacitance transducer off the penetrometer base so that youmay observe the sample
during a trial pump down performed at slightly higher than the usual speed. Twenty percent
increases in pump-down rates and pressures of path changeovers are reasonable trial increases.

B Choose Proper Pump-DownRates for Unfamiliar
SampleMaterials
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B Choose Proper Pump-DownRates for Unfamiliar
SampleMaterials

Monitor closely during all portions of the pump-down sequence, especially as changes from one path
to another occur. Should the sample bed or any particles begin to boil or move, immediately stop the
pump down and return the sample to atmospheric pressure; reduce the pump down rate to a slower
rate and try again. If the pump downwas successful, then another twenty percent speed increase
might be attempted. Continue until a suitable rate is found. Note that this procedure is not without
risk andmust be done very carefully.

The amount of time for which to continue the extended pump down after the lowest target on the
third path has beenmet will depend upon the structure of the sample and what volatile materialsmay
be present within it. Large chunks of porousmaterials such as sandstone or green ceramics or
concretemay present a considerable diffusion barrier for gases and vapors traveling to their surface
andmay require extended exposure times to vacuum to sufficiently clear the internal pores of this
obstructivematter which would prevent fullymeasuring the true porosity. Experience and prior
knowledge of the sample can be used for guidance.

Additionally, a manual mode test can be done in which you pump the sample down to the target
pressure, and then close it off from further vacuum andmonitor the rate and ultimate value of the
pressure rebound that results from the tardy release of gas or vapor. The amount of time before the
rebound ceases or remainswithin tolerable limits will serve to guide you in choosing an extended
evacuation time for future automatic runs of the samplematerial.
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C PROPER HANDLING OF MERCURY

Because of its low melting point (-38.87 ºC), mercury (Hg) is slightly volatile at ordinary room
temperatures and its vapor may pose a health hazard if allowed to accumulate in the work space.
Althoughmercury can enter the body through the skin, lungs or digestive system, breathing air laden
with high concentrations of mercury vapor is themost common cause of mercury poisoning. Chronic
poisoning caused by long-term exposure to low levels of mercury is occasionally found among those
working with mercury. Mining, chemical, electrical, dentistrymaterials, pharmaceutical, explosive,
porcelain, photography, printing, battery, paint, engraving, jewelry, cosmetics and color are some of
the industries that usemercury in their manufacturing or processing.

Governmental agencies, i.e., National Institute for Occupational Safety and Health (NIOSH),
Environmental Protection Agency (EPA), etc., and some industries have set criteria and
recommended standards to protect the health and safety of workers exposed tomercury. A
Threshold Limit Value (TLV) of 0.05mgHg/cubicmeter of air, recommended by the American
Conference of Governmental Industrial Hygienists, was among the first hygienic guides for
controlling exposure of mercury in the U.S. Valueswell below this level can easily bemet through
proper ventilation, prompt and thorough cleanup of spills, good personal hygiene and safe storage
when working with mercury.

Health hazards frommercury can be prevented by limiting the average concentration of mercury to
values below the TLV in an 8-hour workday. This is achieved through proper ventilation in the work
area wheremercury is handled; for example, a local exhaust ventilation system can be designed and
maintained to prevent the accumulation or recirculation of mercury vapor, dust and fume; all handling
of mercury can be confined to a hood, etc. Appropriate protective respiratory devices can be used
whenmercury exposure continues to exceed the recommended standard. To ensure TLV levels are
met, governmental agencies suggest environmental levels of inorganicmercury bemonitored every
sixmonths: breathing-zone samples are collected to permit calculation of a time-weighted average
exposure for every operator. When any time-weighted average exposure is at or above the TLV,
immediate steps are required to reduce exposure below the standard.

Maintaining low temperature wheremercury is used will help limit mercury concentration. Vapor
pressure of mercury goes up exponentially with temperature, for example, 20 ºC: P = 1.20 × 10-3
mmHg. As temperature increases from 20 to 40 ºC, the partial pressure of mercury vapor increases
fivefold.

Proper clean-up of mercury spills and disposal of mercury-contaminated articles will limit exposure.
In a poorly ventilated, closed area, wheremercury spills have not been properly and thoroughly
cleaned, mercury concentration in air can become significantly elevated above the TLV of 0.05mg
per cubicmeter of air. The following figure shows that the equilibrium concentration of mercury at a
room temperature of 25 ºC reaches a level of 20mg per cubicmeter of air. This is 400 times the TLV,
resulting in a dangerouswork environment. Surveys in labswheremercury is routinely used reveal
the presence of mercury in porous surfaces, in pools under cabinets or floors, and inside drawers
and lab equipment. This accumulation can be attributed to the lack of an effective clean-up
procedure for both large and small spills.

C Proper Handling of Mercury
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C Proper Handling of Mercury

Mercury spills should be cleaned immediately and thoroughly bymechanical, chemical or other
appropriatemeans. Micromeritics uses and recommends that you use plastic or rubber gloves and a
small vacuum pump equipped with amercury vapor absorbing filter on the exhaust and a vacuum
probe with amercury trap on the inlet for efficient pick-up of small mercury particles in cleaning
mercury spills. Afterwards, the spill area should be swabbed with amercury decontaminants1 ) and
allowed to dry.

The health status of those working with mercury should bemonitored regularly, with emphasis
placed on good personal hygiene to prevent contamination of hands, mouth, clothing or food. Hand
washing facilities, including hot and cold running water, soap, hand cream, and towels should be
made available adjacent to mercury work areas. Clothing contaminated with mercury should be
stored in vapor-proof containers pending removal for laundering.

1 ) Mercury decontaminantsmay be purchased from Fisher Scientific (800/766-7000) or Lab Safety
Supply (800/356-0783). They alsomay be available from your local laboratory supplier.

C - 2 AutoPore IV Operator Manual
950-42828-01 (Rev A)— Nov 2017



Open containers for storage of mercury in the work area should be covered with an aqueous or an oil
layer and kept at ambient temperatures to prevent vaporization. Because of permeability of
polyethylene or plastic bottles tomercury vapor, thick glass bottles, stainless steel or cast iron
containers are recommended for storingmercury. To avoid dangerous chemical reactions, mercury
should not be stored with acetylene, fulminic acid, ammonia and oxalic acid.

PROPER USE OF MERCURY AS A TOOL IN PORE STRUCTURE
ANALYSES
Micromeritics’ Mercury Intrusion Porosimeters obtain accurate and reproducible pore structure
analyses usingmercury. Mercury is ideal as an intrusion liquid in the porosimetrymethod because it
does not wet nor react with most materials. Bymeasuring the amount of mercury intruded into the
pores of a powdered or solid sample, the porosimeters give valuable data fromwhich pore size,
volume and distribution, as well as apparent densities, pore surface area and particle size can be
determined.

All of Micromeritics’ porosimetry instruments are designed with safety in mind. They come equipped
with built-in spill and vapor safeguards that minimize operator exposure tomercury. They also are
designed so that youmay connect them to a ventilation system that pulls ambient air over the
counter, through the instrument and out a duct at the rear. A built-in tray work area allows the
operator to easily wipe exposedmercury to a dish where it is covered with oil. Our product literature
on porosimetry supplies detailed site recommendations to assure safe operation.

Mercury vapor levels well below the accepted safe level can easily be achieved through regular
monitoring, diligent handling and proper clean-up practices.

Proper Use of Mercury as a Tool in Pore Structure Ana-
lyses
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D THEORY
Mercury porosimetry is based on the capillary law governing liquid penetration into small pores. This
law, in the case of a non-wetting liquid likemercury and cylindrical pores, is expressed by the
Washburn equation

whereD is pore diameter,P the applied pressure, γ the surface tension, and ϕ the contact angle, all
in consistent units. The volume of mercuryV penetrating the pores ismeasured directly as a function
of applied pressure. ThisP-V information serves as a unique characterization of pore structure.

Pores are rarely cylindrical, hence the above equation constitutes a special model. Such amodel
may not best represent pores in actual materials, but its use is generally accepted as the practical
means for treating what, otherwise, would be amost complex problem.

The surface tension of mercury varies with purity; its usually accepted value and the value
recommended here is 485 dynes/cm. The contact angle betweenmercury and the solid containing
the pores varies somewhat with solid composition. A value of 130 degrees is recommended in the
absence of specific information to the contrary.

Mercury extruding from pores upon reduction of pressure is in general accord with the above
equation, but indicated pore diameters are always offset toward larger diameters. This results from
equivalent volumes of mercury extruding at pressures lower than those at which the poreswere
intruded. It is also commonly observed that actual pores always trapmercury. The first phenomena
is usually attributed to receding contact angles being less than advancing ones. The second is likely
due to pore irregularities giving rise to enlarged chambers and “inkwell” structures. These
phenomena give rise to hysteresis phenomena, i.e., distinct intrusion and extrusionP-V curves.

Log in to your customer portal to access the Calculations document for a discussion on Pore Surface
Area Computation.

D Theory
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E USE OF THE MAXIMUM INTRUSION VOLUME OPTION

Using themaximum intrusion volume option allows routine analyseswith fewer points in a pressure
table while maintaining good resolution. However, use of themaximum intrusion volume requires
some knowledge of the total pore volume of the sample to be analyzed. You should use about 2% of
the sample’s total pore volume as themaximum intrusion volume. This would give about fifty points
for the intrusion pore spectrum and should be adequate to completely characterizemost samples.
The AutoPore IV will automatically add a pore spectrum point any time it sees an increment of
intrusion equal to themaximum intrusion volume specified.

Care should be taken not to use too small a maximum intrusion volume. Use of a value less than
0.4% of the total intrusion volumewill cause toomany points to be taken at lower pressures. The
total of 1000 data points will be exhausted and the analysis will terminate prematurely.

Use of too small a maximum intrusion volume can also cause points to be taken too close together on
the pressure axis. If this causes pressures to be taken within the target pressure tolerance of each
other, an apparent pressure decreasemay be reported during the intrusion sequence. A reported
pressure drop greater than 10 psi or 0.5% of the target pressure will be interpreted as the end of the
intrusion segment. Reported summary data (such as total intrusion volume) will be reported at this
point, rather than at themaximumpressure as intended. Data for graphs other than cumulative
intrusion volumewill also be terminated at this point.

E Use of theMaximum Intrusion VolumeOption
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F WORKSHEETS

Worksheets in this sectionmay be copied as needed.

See also:

l Analysis Conditions Worksheet on the next page
l Penetrometer Properties Worksheet on page F - 3
l Pressure Table and Tabular Data Worksheet on page F - 4
l Report Options Worksheet on page F - 5
l Sample Data Worksheet on page F - 6
l Volumetric Reference Capsule Worksheet on page F - 7

FWorksheets
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FWorksheets

ANALYSIS CONDITIONS WORKSHEET

File Name: __________________________________________________________

Analysis conditions identifier

Low pressure equilibration
¨ Time ¨Rate

Max. intrusion volume

Evacuation Initially evacuate at

Switch tomedium at

Switch to fast at

Evacuation target

Continue evacuating for

High pressure equilibration ¨ Time ¨Rate

¨Pressure-controlled scan

¨ Intrusion-controlled scan

Max. intrusion volume

Advancing contact angle

Receding contact angle

Hg surface tension

Hg density

Mercury Properties
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PENETROMETER PROPERTIES WORKSHEET

File Name: __________________________________________________________

Penetrometer Number (etched on pen-
etrometer)

Mass.Weigh the loaded penetrometer.
Subtract themass of the sample. Enter
the difference.

Volume

Constant

Stem Volume

Max. head pressure

Correction method

¨ Blank ¨ Formula ¨ None

If Blank, give file name:

Penetrometer Properties Worksheet
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FWorksheets

PRESSURE TABLE AND TABULAR DATA WORKSHEET

l For pressure table, enter:

Filling pressure: ________________________________________________
Last low pressure point index: ____________________________________

l For tabular data, select:

¨Pressure
¨Pore size
¨Percent intrusion

Entry Entry Entry Entry
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REPORT OPTIONS WORKSHEET

File name

Calculation range

¨ Pressure¨ Pore size

Reports

Overlays

Sample 1 Sample 5

Sample 2 Sample 6

Sample 3 Sample 7

Sample 4 Sample 8

Report OptionsWorksheet
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FWorksheets

SAMPLE DATA WORKSHEET

______ Basic presentation sample file

______ Advanced presentation sample file

Port 1 Port 2 Port 3 Port 4

Sample file name or identifier (optional)

Penetrometer number (optional - etched
on penetrometer)

Sample mass(g). Enter this value on the
Sample Description tab.

Sample + penetrometer mass. Load the
penetrometer with sample and weigh.

Penetrometer mass. Subtract the sample
mass from theSample + penetrometermass
and enter the difference.

l If using Basic presentation, enter this
value on theSample Informationwindow.

l If using Advanced presentation, enter this
value on thePenetrometer Propertieswin-
dow.

High pressure port number (optional).
Enter the number of the high pressure port
where the sample is loaded.

Assembly mass. Themass of the sample
+ penetrometer + mercury. (Weigh the pen-
etrometer after the low pressure analysis.)
Enter this value on theStart High Pressure
Analysiswindow.
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VOLUMETRIC REFERENCE CAPSULE
WORKSHEET

Calculate the volumetric reference capsule volume three times, then record the average of these
calculations.When creating the penetrometer properties file, enter the average volume.

Penetrometer Number Date:
By:

First Calibration of Reference Capsule Volume:

1. Mass of capsule filled with mercury g
2. Mass of sealed, empty capsule g
3. Mass of mercury (line 1minus line 2) g

RoomTemp = _____________ °C Density of mercury * = g/ml
4. Volume of capsule (line 3 ÷ density of mercury) ml

Second Calibration of Reference Capsule Volume:

1. Mass of capsule filled with mercury g
2. Mass of sealed, empty capsule g
3. Mass of mercury (line 1minus line 2) g

RoomTemp = _____________ °C Density of mercury * = g/ml
4. Volume of capsule (line 3 ÷ density of mercury) ml

Third Calibration of Reference Capsule Volume:

1. Mass of capsule filled with mercury g
2. Mass of sealed, empty capsule g
3. Mass of mercury (line 1minus line 2) g

RoomTemp = _____________ °C Density of mercury * = g/ml
4. Volume of capsule (line 3 ÷ density of mercury) ml

Average Reference Capsule Volume: ml

*    SeeDensity of Mercury Table on the next page for values.

Volumetric Reference CapsuleWorksheet
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FWorksheets

DENSITY OF MERCURY TABLE

°C g/ml °C g/ml °C g/ml °C g/ml
18.0 13.5512 23.2 13.5384 25.2 13.5335 27.2 13.5286
19.0 13.5487 23.4 13.5379 25.4 13.5330 27.4 13.5281
20.0 13.5462 23.6 13.5374 25.6 13.5325 27.6 13.5276
21.0 13.5438 23.8 13.5369 25.8 13.5320 27.8 13.5271
22.0 13.5413 24.0 13.5364 26.0 13.5315 28.0 13.5266
22.2 13.5408 24.2 13.5359 26.2 13.5310 29.0 13.5242
22.4 13.5403 24.4 13.5354 26.4 13.5305 30.0 13.5217
22.6 13.5399 24.6 13.5350 26.6 13.5301 31.0 13.5193
22.8 13.5394 24.8 13.5345 26.8 13.5296 32.0 13.5168
23.0 13.5389 25.0 13.5340 27.0 13.5291 33.0 13.5144

Density of Mercury Table
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G EXPORTED DATA EXAMPLE

GExported Data Example
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GExported Data Example
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H COMPUTE VOLUMETRIC COMPRESSIBILITY OF A SAMPLE
MATERIAL

Ideally, you should choose a samplematerial that is completely non-porous; if this is not the case,
then you should choose the pressure range over which the compressibility test is conducted such
that no pore filling occurs within it. Closed poresmay not always cause volume changes during
testing but theymay alter the results due to stress concentrations around them or because of their
effects uponmeasured density. Closed poresmay also abruptly fail and even become open during
testing and cause invalid compressibility results to be reported. In some cases, such as the testing of
plastic foams at low pressures, the presence of closed poresmay be acceptable and expected.

The samplemass and sample densitymust be known and available to a resolution and accuracy at
least three significant digits (preferably better) to permit accurate computation of the initial volume of
the samplematerial. Alternatively, an accurate geometric volume of amaterial such as one
containing closed pores (such as plastic foam) may be supplied. Before data reduction can be
performed, youmust have available a “blank run” file consisting (at least ideally) of a runmadewith
the same penetrometer and accessory hardware that is to be used in the compressibility test and
(again ideally) on the same instrument ports aswill be used in the compressibility run. The pressure
range of the blank runmust, at aminimum, fully encompass the planned range to be used in the
compressibilitymeasurement and have aminimumof seven uniformly spaced (linear basis) data
points inside the planned computation range and with the beginning and ending data points within
5% (pressure) of the planned computation range end points. It is also permissible for the “blank run”
to consist of amanually entered data file.

The first and second order isostatic pressure coefficients of volumetric compressibility for mercury
over the pressure range from zero psia to 60,000 psiamust be known and available. All standard
input information such as samplematerial identity, equilibration times, evacuation information,
penetrometer constants, etc. that would be required for standard runs is required for a
compressibility run. Note that sample volume, bulk volume / density, and skeletal volume / density as
measured during themercury porosimetry run are, in general, far too imprecise to yield good results
if used in the compressibility computations. For this reason, youmust enter very accuratematerial
density and samplemass values to be used in computing an accurate initial sample volume or,
alternatively, directly enter ameasured initial samplematerial volume.

The pressure table enteredmust contain at least seven pressure points uniformly spaced (on a linear
basis), with these points coinciding as closely as possible to those in the blank run which is to be used
along with the data in the final computation. As indicated above, the pressure values of the end
points achieved during the runmust be within 5%

H Compute Volumetric Compressibility of a SampleMater-
ial
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